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Лабораторная работа № 1 

Интегрированная среда разработки mikroC Pro  

для PIC-микроконтроллеров  

1 Цель работы 

Изучить и практически исследовать методы разработки и отлад-

ки программ на языке Си для PIC-микроконтроллеров с помощью ин-

тегрированной среды разработки mikroC PRO for PIC. 

2 Основные теоретические сведения 

Для создания программного обеспечения микроконтроллерных 
систем широко используются средства вычислительной техники,  

в том числе персональные компьютеры, позволяющие разработчику 
выполнить весь цикл проектирования, включая отладку целевой про-
граммы. 

В настоящее время самым мощным средством разработки про-
граммного обеспечения для микроконтроллеров являются интегриро-
ванные среды разработки (IDE – Integrated Development Environment), 

имеющие в своем составе текстовый редактор, компилятор языков 
высокого уровня типа Паскаль или Си, отладчик-симулятор, а также 
библиотеки готовых функций.  

Одним из таких программных инструментов является среда раз-
работки mikroC PRO компании MikroElektronika. Данная среда разра-
ботки позволяет быстро создавать эффективные программы на рас-
пространенном языке высокого уровня Си. Среда имеет удобный 

интерфейс пользователя со встроенным редактором текста и мощным 

отладчиком программ. Встроенный мастер проектов позволяет в счи-

танные минуты создать заготовку рабочей программы для любого 
микроконтроллера из целого семейства. Библиотека готовых функций 

обеспечивает программиста поддержкой для быстрого и безошибоч-
ного создания программы. Компания MikroElektronika создала среду 
разработки mikroC PRO для таких популярных микроконтроллеров, 
как семейство PIC компании Microchip, AVR компании Atmel и се-
мейство MCS-51. 

В лабораторных работах будет использоваться интегрированная 
среда разработки для PIC-микроконтроллеров – mikroC PRO for PIC. 
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С сайта www.mikroe.com компании MikroElektronika можно бесплат-
но скачать демонстрационную версию среды mikroC PRO for PIC, ко-
торая позволяет создавать программы с объемом исполняемого кода 
до 2 Кбайт.  

Разработка программного обеспечения при использовании  

mikroC PRO состоит из следующих основных этапов: 
1 Создание проекта. 
2 Создание исходных файлов на языке mikroC. 

3 Построение проекта. 
4 Тестирование программы и ее отладка. 
Среда mikroC PRO организует программное обеспечение в виде 

проектов, состоящих из одного файла проекта (файл с расширением 

*.mcppi) и одного или нескольких исходных файлов на языке mikroC 

(файлов с расширением *.c). Исходные файлы могут компилироваться 
только в том случае, если они включены в проект. 

Файл проекта содержит: 
� имя проекта; 
� тип микроконтроллера; 
� тактовую частоту его работы; 

� слово конфигурации микроконтроллера; 
� список исходных файлов для проекта; 
� другие (вспомогательные) файлы. 

3 Порядок выполнения работы 

3.1 Создание папки для работы в mikroC PRO for PIC 

3.1.1 Для выполнения лабораторных работ по дисциплине «Мик-
ропроцессорная техника» вам необходимо создать на компьютере свою 

рабочую папку. Сделать это можно следующим образом. 

На панели TotCom выберите диск F. Затем выберите папку MPT 

и раскройте ее. Внутри нее создайте новую папку (с помощью клави-

ши F7) с именем, соответствующим вашей фамилии (буквы обяза-
тельно латинские), например: Ivanov. 

Примечание. При использовании в именах папок русских букв возможна 
неправильная работа исследуемых программ.   
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В дальнейшем вы будете записывать и хранить в вашей папке все 
файлы в процессе выполнения лабораторных работ. Полный путь к ней: 

F:\MPT\Ivanov 

3.1.2 При выполнении лабораторных работ вы будете создавать 
много различных файлов. Для того чтобы было легче ориентировать-
ся в них, желательно для каждой лабораторной работы иметь свою 

отдельную папку. Допустим, что для выполнения лабораторной рабо-
ты № 1 мы будем использовать папку с именем Lab1, которую необ-

ходимо предварительно создать. 
С этой целью откройте вашу рабочую папку (с именем, соответ-

ствующим вашей фамилии) и создайте в ней (с помощью клавиши F7) 

новую папку с именем Lab1. 

В дальнейшем вы будете записывать и хранить в этой папке все 
файлы в процессе выполнения лабораторной работы № 1. Полный 

путь к ней: 

F:\MPT\Ivanov\Lab1 

3.2 Запуск mikroC PRO for PIC 

Интегрированная среда mikroC PRO for PIC запускается из стар-
тового меню Windows, подобно остальным приложениям, либо, что 
удобнее, с помощью ярлычка с надписью “mikroC PRO for PIC” на 
рабочем столе компьютера. 

После запуска программы на экране компьютера вы увидите ра-
бочий стол среды mikroC PRO for PIC. В верхней части экрана нахо-
дится строка заголовка, в которой выводится имя проекта. Под ней 

расположена строка главного меню. Главное меню содержит обшир-
ный набор команд для доступа к функциям mikroC PRO for PIC. 

В центре экрана располагается окно Get Started с различными сер-
висными функциями для помощи начинающим пользователям. В левой 

части экрана расположены команды для создания нового проекта (New 

Project…), открытия существующего проекта (Open Project…) и от-
крытия папки примеров (Open Examples Folder…). В нижней части эк-
рана находится окно сообщений. Стартовую страницу можно открыть 
также с помощью команды меню View > Start Page.  

Рассмотрим методику разработки программного обеспечения  
в интегрированной cреде mikroC PRO for PIC на примерах простей-

ших программ для микроконтроллера PIC16F84A. 
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3.3 Первая программа вывода данных 
 в порт микроконтроллера 

Вот текст первой программы: 
 

/********************************************************** 
 out.c – программа вывода данных в порт B  
**********************************************************/ 
void  main( ) 
{ 
     TRISB = 0;                   // настроить все линии порта В на вывод    
     PORTB = 0xFF;           // вывод данных (все единицы) в порт В 
     PORTB = 0x00;           // вывод данных (все нули) в порт В         
} 
 

3.3.1 Создание нового проекта. Процесс создания нового проек-
та в среде mikroC PRO очень прост. Подведите курсор мыши  
к строке команды для создания нового проекта New Project… и щелк-
ните левой кнопкой. 

На экране появится окно мастера создания нового проекта – New 
Project Wizard. Начальное окно содержит список действий, которые 
должны быть выполнены для создания нового проекта. Этот процесс 
разбит на несколько шагов (Steps), которые вы должны последователь-
но проделать. 

Для продолжения щелкните по кнопке [Next]. 

Шаг 1 Установка настроек проекта 
На этом шаге необходимо определить общую информацию для 

проекта: выбрать микроконтроллер, его тактовую частоту и, конечно, 
дать проекту название. Это очень важный этап, так как компилятор 
создает внутренние настройки на основе этой информации. По умол-
чанию мастер проекта предлагает определенные настройки, но в на-
шем случае их требуется изменить. С этой целью проделайте сле-
дующее: 

1 Очистите строку Project Name и введите новое имя проекта. 
При выборе имени проекта желательно, чтобы оно имело какую-то 
смысловую нагрузку. В нашей первой программе будет выполняться 
вывод данных в порт микроконтроллера (МК), поэтому можно дать 
имя этому проекту как out (вывод). Напоминаем, что mikroC PRO ис-
пользует только латинские буквы. Использование кириллицы недо-
пустимо! 
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Итак, введите имя проекта – out (расширение *.mcppi набирать 
не нужно!). В строке Project Name должно быть: 

Project Name:   out 

2 Для выбора папки хранения проекта щелкните по кнопке 
[Browse] – обзор. Откроется окно обзора папок. Последовательно вы-

берите и раскройте нужные папки в соответствие с установленном  

в п. 3.1.2 пути f:\MPT\Ivanov\Lab1. Последней должна быть папка  
с именем Lab1. Щелкните по ее имени для открытия. В заключение 
щелкните по кнопке [OK] для подтверждения своего выбора и уста-
новке нового пути. В строке Project Folder должно появиться имя пап-

ки Lab1 и полный путь к ней: 

Project Folder:  f:\MPT\Ivanov\Lab1\ 

3 Введите новое имя для микроконтроллера – PIC16F84A. С этой 

целью щелкните по стрелке в правой части строки Device Name. В рас-
крывшемся списке PIC-микроконтроллеров выберите P16F84A и щелк-
ните по этой строке. В строке Device Name должно появиться: 

Device Name:  P16F84A 

4 И, наконец, необходимо установить в строке Device Clock так-
товую частоту работы микроконтроллера. По умолчанию она равна  
8 МГц. Для нашего первого проекта можно оставить это значение. 

5 В заключение шага 1 щелкните по кнопке [Next] для продол-
жения. 

Шаг 2 Добавление файлов 
Этот шаг позволяет вам включить дополнительные файлы, ко-

торые будут необходимы для вашего проекта, например, некоторые 
заголовочные файлы. В нашем случае нет необходимости подключать 
какие-либо дополнительные файлы, поэтому просто щелкните по 
кнопке [Next] для продолжения. 

Шаг 3 Подключение библиотек 
Этот шаг позволяет вам определить, желаете ли вы включить все 

библиотеки в ваш проект или нет. Следует знать, что, даже если все 
библиотеки включены, они не требуют какой-либо дополнительной 

памяти, если они не используются в вашей программе. Главное досто-
инство опции подключения всех библиотек в том, что вы получаете 
возможность использования в вашей программе свыше 500 готовых 
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функций, поэтому следует оставить эту конфигурацию по умолчанию, 

однако убедитесь, что флажок на кнопке [Include All (Default)] уста-
новлен. 

Щелкните по кнопке [Next] для продолжения. 

Шаг 4 Окончание построения проекта 
После того, как все необходимые настройки для проекта выпол-

нены, заключительный шаг позволяет вам сделать дополнительные 
действия. 

Имеется возможность разрешить автоматическое открытие окна 
редактирования проекта после завершения работы мастера проекта.  
С помощью этого окна можно изменять биты конфигурации микро-
контроллера. Это окно также может быть открыто в любой момент 
разработки программы с помощью команды меню Edit > Project.  

Следует отметить, что в результате предыдущих шагов масте-
ром проекта были установлены для микроконтроллера PIC16F84A 

следующие биты конфигурации: 

HS – высокочастотный генератор (тактовая частота от 4 до 20 МГц); 

WDT off – сторожевой таймер WDT отключен; 

Code Protection off – отключена защита кода от чтения, т. е. мож-

но читать и записывать код в микроконтроллер. 
Для выполнения лабораторных работ можно оставить эту кон-

фигурацию МК по умолчанию. 

Поэтому для окончания построения проекта просто щелкните по 
кнопке [Finish]. 

Результатом работы мастера проектов будет новый проект 
out.mcppi, имя которого вместе с указанием полного пути к нему поя-
вится в строке заголовка в верхней части рабочего стола среды mik-

roC PRO for PIC.  

В центре рабочего стола откроется окно редактора кода с пус-
тым исходным файлом для текста программы на языке mikroC: 

 

void  main( ) {  

} 

 

Исходный файл по умолчанию имеет то же имя, что и проект, 
т. е. out.c. Следует отметить, что среда mikroC PRO не требует, чтобы 

исходный файл имел такое же название, как и у проекта, поэтому 
файл можно переименовать. 



 9

3.3.2 Создание исходного файла. Наберите в окне редактора кода 
текст программы вывода данных в порт В микроконтроллера. Текст 
комментария для экономии времени можно не набирать. 

Замечание. При наборе текста программы обязательно делайте 
отступы (3–4 пробела), как это выполнено в примере. Отступы облег-
чают чтение программы: 

 

/********************************************************* 

 out.c – программа вывода данных в порт B  

**********************************************************/ 

void  main( ) 

{ 

     TRISB = 0;                   // настроить все линии порта В на вывод    

     PORTB = 0xFF;           // вывод данных (все единицы) в порт В 

     PORTB = 0x00;           // вывод данных (все нули) в порт В         

} 

 

После набора сохраните файл out.c, выполнив команду меню 

File > Save. 

3.3.3 Построение проекта. Построение проекта в mikroC PRO – 

это процесс компиляции исходных файлов, их компоновки и создание 
hex-файла, предназначенного для загрузки в программную память 
микроконтроллера. Для построения проекта надо выполнить команду 
меню Build > Build. После процесса компиляции и компоновки в окне 
Messages (в нижней части экрана) выдается сообщение об итогах по-
строения. Сообщение содержит информацию о количестве затрачен-

ных ресурсов памяти, наличии ошибок (Errors) и предупреждений 

(Warnings). 

Возникающие ошибки (обычно синтаксические) не позволяют 
компилятору сгенерировать машинные коды программы на основе 
исходного текста, поэтому такие ошибки обязательно должны быть 
исправлены. При наличии ошибок выводится сообщение “Finished 

(with errors)”. 

Предупреждения выдаются компилятором в том случае, когда 
он может сгенерировать машинные коды, но в процессе их формиро-
вания возникли обстоятельства, требующие внимания разработчика.  

Если в результате построения проекта возникли сообщения об 

ошибках или предупреждения, то их перечень с указанием номера 
строки и типа ошибки отобразится (красным цветом) в окне Messages. 
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Место ошибки в исходном тексте можно легко найти, дважды щелк-
нув левой кнопкой мыши на строке соответствующего сообщения. 

Если ошибок нет, то в окне Messages появится сообщение (голу-
бого цвета) с текстом “Finished successfully”. 

После успешной компиляции mikroC PRO генерирует выходные 
файлы, которые помещаются в папку с файлом проекта: 

� ассемблерный файл (с расширением *.asm). Содержит коман-
ды Ассемблера, сгенерированные компилятором; 

� файл листинга (с расширением *.lst). Это общая картина рас-
пределения памяти микроконтроллера: адреса команд, регистры, про-
граммы и метки; 

� HEX-файл (с расширением *.hex). Это основной выходной 
файл, который используется для загрузки кодов программы в память 
микроконтроллера. 

Выходные файлы по умолчанию имеют то же имя, что и файл 
проекта. Ассемблерный файл и листинг могут быть просмотрены  
с использованием команд меню View. 

Задание. Выполните построение проекта out.mcppi с помощью 
команды меню Build > Build. По содержимому окна Messages озна-
комьтесь с итогами построения проекта. 

3.3.4 Тестирование программы с помощью симулятора-отлад-
чика. Среда mikroC PRO имеет средства отладки, позволяющие про-
верить работоспособность программы и исправить при необходимо-
сти ошибки в исходном тексте. Отладку можно выполнять как с по-
мощью внутреннего симулятора работы микроконтроллера, так  
и с помощью аппаратного отладчика, подключив к нему целевую 
микроконтроллерную систему. По умолчанию отладчик mikroC PRO 
настроен для работы в режиме симулятора. 

Для запуска отладчика надо выполнить команду из меню  
Run > Start Debugger. В результате mikroC PRO перейдет в режим 
отладки (в нем текущая строка исходного кода обозначается зеленой 
стрелкой и по умолчанию выделяется синим цветом) и откроется  
окно наблюдения Watch Values, позволяющее отслеживать в ходе вы-
полнения программы содержимое различных переменных и регист-
ров. Значения обновляются в процессе симуляции работы программы  
в отладчике. Последние измененные элементы в окне наблюдения 
выделяются красным цветом.  

Замечание. Если после запуска отладчика на экране будет отсут-
ствовать окно наблюдения Watch Values, то его можно открыть с по-
мощью команды меню View > Debug Window > Watch Window.  
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Для внесения в список окна наблюдения Watch Values той или 
иной переменной программы, значение которой необходимо отсле-
живать, ее нужно выбрать в раскрывающемся списке строки Select 
variable from list и нажать кнопку [Add].  

После того как переменная добавлена в список окна Watch Val-
ues, можно настроить параметры отображения ее в столбце Value. Для 
этого можно воспользоваться одним из способов: 

� дважды щелкнуть левой кнопкой мыши на соответствующей 
строке списка Watch Values в столбце Name или Address; 

� щелкнуть левой кнопкой мыши в столбце Value и затем нажать 
расположенную справа кнопку […]. 

В любом случае на экране появится диалоговое окно Edit Value, 
позволяющее отредактировать значение переменной прямо в ходе 
выполнения программы или же изменить формат ее отображения. 

Для выбора формата отображения необходимо установить фла-
жок в соответствующем окошке: 

� Dec – десятичный; 
� Hex – шестнадцатеричный; 
� Bin – двоичный; 
� Float – с плавающей точкой; 
� Char – символьный. 
Установка флажка Signed означает активизацию отображения 

знака. 
Для того чтобы подтвердить изменения, внесенные в значение 

или формат отображения переменной, в диалоговом окне Edit Value 
следует нажать кнопку [OK]. Нажатие кнопки [Cancel] отменяет все 
внесенные изменения. 

Для удаления текущего элемента в списке Watch Values служит 
кнопка [Remove], а для полной очистки этого списка – кнопка [Re-
move All]. 

В режиме отладки открывается также окно хронометража Watch 
Clock. В нем отображается текущий счетчик Current Count командных 
(машинных) циклов и времени в микросекундах (us) от момента запуска 
отладчика. Секундомер (Stopwatch) измеряет время исполнения в коли-
честве командных циклов и микросекундах от момента запуска отлад-
чика и может быть обнулен в любой момент. Разность (Delta) представ-
ляет фактическое время выполнения участка программы от предыдущей 
точки останова до текущей, отображаемое в количестве командных 
циклов и микросекундах (при пошаговом исполнении отображается 
время выполнения одной строки кода программы на mikroC). 
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Также в окне Watch Clock отображается текущая тактовая час-
тота микроконтроллера (Clock). Тактовую частоту в окне хрономет-
ража можно изменять, что приведет к пересчету времени в микросе-
кундах. Однако это изменение не влияет на текущие установки 

проекта, где также задана тактовая частота микроконтроллера, а влия-
ет только на расчет времени симуляции.   

Управлять процессом отладки можно тремя способами: 

1) с помощью пунктов меню Run; 

2) при помощи «горячих клавиш» клавиатуры; 

3) с использованием кнопок (значков) в окне Watch Values. 

Практика показывает, что наиболее удобно для отладки исполь-
зовать именно кнопки окна Watch Values.  

Примечание. Чтобы узнать функцию кнопки (значка), нужно поместить 
курсор мыши на эту кнопку. На экране появится описание этой функции. 

 

Название и функция основных кнопок управления отладкой  

(а также соответствующих клавиш клавиатуры) следующие: 
Start Debugger (F9) – запуск отладчика; 
Run/Pause Debugger (F6) – запуск/останов программы в непре-

рывном (автоматическом) режиме; 
Stop Debugger (Ctrl + F2) – прекращение работы отладчика; 
Step Into (F7) – шаг на одну строку программы; 

Step Over (F8) – шаг через одну строку программы; 

Step Out (Ctrl + F8) – шаг из функции; 

Run To Cursor (F4) – выполнять до курсора; 
Toggle Breakpoint (F5) – поставить/удалить точку останова. 
Команда Step Into позволяет «шагать» по каждой строке исход-

ного текста. При помощи ее можно войти в вызываемую функцию. 

Команда Step Over позволяет «перешагнуть» через вызываемую 

функцию, не входя внутрь, а выполнив ее как единое целое. 
Для завершения работы с отладчиком в любой момент следует 

выбрать из меню команду Run > Stop Debugger. Произойдет возврат 
в режим редактирования. 

Задание. Выполните тестирование и отладку в mikroC PRO пер-
вой программы вывода в порт  out.c. С этой целью перейдите в режим 

отладки с помощью команды меню Run > Start Debugger.  

Чтобы проверить работу программы  out.c, нужно следить за со-
стоянием выводов порта B, которые отображаются переменной PORTB. 
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Для занесения в окно наблюдения переменной подведите курсор мыши 

к строке Select variable from list (Выбрать переменную из списка)  
и щелкните по стрелке в правой части. В раскрывшемся списке выбери-

те строку PORTB и щелкните по ней. Для добавления выбранной пере-
менной PORTB в список окна наблюдения щелкните по кнопке [Add]. 

Строка с переменной PORTB (желтого цвета) появится в окне наблю- 

дения.  
Выполните программу out.c в пошаговом режиме Step Over,  

используя соответствующую кнопку управления отладкой или кла-
вишу F8. При каждом шаге синяя полоса будет перемещаться по тек-
сту программы. Наблюдайте за значением переменной PORTB на  
каждом шаге. 

Выполнение программы out.c прекращается при достижении 

правой фигурной скобки функции main( ). Для возможности нового 
выполнения программы нужно произвести сброс микроконтроллера. 
Это можно сделать путем повторного запуска отладчика командой 

Run > Start Debugger или щелчком по соответствующей кнопке 
управления отладкой в окне Watch Values. 

Значения переменных в окне наблюдения по умолчанию отобра-
жаются в десятичном формате. В программе out.c значения PORTB  

записаны в шестнадцатеричном формате. Для изменения формата ото-
бражения щелкните два раза по строке PORTB. В раскрывшемся окне 
редактирования Edit Value PORTB поставьте флажок в окошке HEX. 

Затем щелкните по кнопке [OK] для подтверждения выбора и закрытия 
окна редактирования. 

Выполните вновь программу out.c в пошаговом режиме Step 

Over. Убедитесь, что формат отображения PORTB стал шестнадцате-
ричным.  

Для завершения работы с отладчиком нужно выполнить коман-

ду меню Run > Stop Debugger, при этом происходит возврат в режим 

редактирования. 
В заключение закройте проект с помощью команды Project > Close 

Project.  

3.4 Вторая программа вывода в порт 

Во второй программе происходит бесконечный цикл вывода  
в порт B микроконтроллера, т. е. состояния выходов порта цикличе-
ски переключаются.    
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Текст исходной программы: 

 

/********************************************************* 

 out2.c – вторая программа вывода данных в порт B 

**********************************************************/ 

void main( ) 

{ 

       TRISB = 0;                     // настроить линии порта В на вывод 
        while(1)                         // бесконечный цикл повторения 
       { 

             PORTB  = 0xFF;            // вывод единиц в порт В 

             PORTB = 0x00;            // вывод нулей в порт В 

        } 

} 

 

Задание. Для исследования программы создайте новый проект  
с именем out2 и поместите его в папку Lab1, микроконтроллер 
PIC16F84A, тактовая частота 8 МГц. Наберите текст программы  

в файле out2.c и сохраните его в папке. Выполните построение проек-
та, а затем перейдите в режим отладки. 

Для тестирования программы занесите в окно наблюдения 
Watch Values имя порта РORTB из исходной программы. Установите 
HEX-формат отображения PORTB.  

Выполните программу в пошаговом режиме Step Over. После 
нескольких шагов убедитесь, что состояния выходов порта В цикли-

чески переключаются. 
Можно узнать время, затраченное на выполнение каждого опе-

ратора, в строке программы по секундомеру, который находится в ок-
не хронометража Watch Clock. В строке Delta показывается количест-
во командных циклов и время в микросекундах (us), затраченных на 
выполнение одной строки исходной программы. 

Продолжайте выполнять программу в пошаговом режиме Step 

Over и наблюдайте за показаниями в окне Watch Clock. При каждом 

шаге показания секундомера Stopwatch будут увеличиваться. По зна-
чениям в строке Delta: следует, что оператор вывода в порт (строка 
программы) выполняется за время 1 мкс.  

Выполните сброс МК с помощью команды Run > Start Debug-

ger или щелчком по соответствующей кнопке управления в окне 
Watch Values. 
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Теперь запустите программу в автоматическом режиме с помо-
щью кнопки управления Run/Pause Debugger или нажатием на клави-
шу F6. При работе программы в автоматическом режиме значения  
переменной PORTB не обновляются, а в окне хронометража идет от-
счет времени от момента запуска. 

Остановите выполнение программы повторным щелчком по кноп-
ке управления Run/Pause Debugger или нажатием на клавишу F6. Зеленая 
стрелка слева от текста программы покажет номер строки, на которой 
произошел останов выполнения. Значение переменной PORTB (красного 
цвета) обновится. В окне Watch Clock будет отображаться общее время 
выполнения программы в автоматическом  режиме от момента запуска.  

Для завершения работы с отладчиком выполните команду меню 
Run > Stop Debugger, при этом произойдет возврат в режим редакти-
рования. 

В заключение закройте проект с помощью команды Project > Close 

Project.  

3.5 Программа вывода в порт с временной задержкой 

Из результатов исследования программы out2.c следует, что вы-
вод в порт (одна строка программы) выполняется за 1 мкс. Очевидно, 
что если бы к порту были присоединены светодиоды, то их переклю-
чение было бы незаметно. Следовательно, необходимо ввести вре-
менную задержку между переключениями состояний выводов порта. 

Рассмотрим программу, в которой между переключениями вы-
ходов порта В имеется временная задержка: 

 
/********************************************************** 
 out3.c – программа вывода данных в порт В с временной задержкой   
**********************************************************/ 
void main( ) 
{ 
      TRISB = 0; 
      while(1) 
      {  
            PORTB = 0xFF; 
            Delay_ms(500);       // временная задержка на 500 мс 
            PORTB = 0x00; 
            Delay_ms(500);       // временная задержка на 500 мс 
       } 
} 
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В программе out3.c для реализации временной задержки исполь-
зуется встроенная функция компилятора mikroC PRO for PIC 

Delay_ms(time_in_ms), 

где параметр time_in_ms – требуемое время задержки в миллисекун-

дах. Это целое число в пределах от 1 до 4294697295. 

Задание. Для исследования программы создайте новый проект  
с именем out3 и поместите его в папку Lab1, микроконтроллер 
PIC16F84A, тактовая частота 8 МГц. Наберите текст программы  

в файле out3.c и сохраните его в папке. Выполните построение проек-
та, а затем перейдите в режим отладки. 

Для тестирования программы занесите в окно наблюдения 
Watch Values имя порта РORTB из исходной программы. 

Выполните программу в пошаговом режиме Step Over. По показа-
ниям в строке Delta окна хронометража убедитесь, что время задержки 

равно заданному в программе и реализовано компилятором с высокой 

точностью.  

Для завершения работы с отладчиком выполните команду меню 

Run > Stop Debugger, при этом произойдет возврат в режим редакти-

рования. 
В заключение закройте проект с помощью команды Project > Close 

Project.  

4 Содержание отчета 

Наименование и цель работы. Тексты исследуемых программ 

(комментарии в программах обязательны!). 

Контрольные вопросы 

1 Что такое IDE mikroC PRO for PIC? 

2 Какие функции выполняет mikroC PRO for PIC? 

3 Поясните процесс разработки программного обеспечения  
в mikroC PRO for PIC. 

4 Что такое проект в mikroC PRO? 

5 На каком этапе осуществляется выбор микроконтроллера? 

6 Какие окна используются в симуляторе для наблюдения за хо-
дом выполнения программы? 

7 Как можно осуществить пошаговое выполнение программы? 
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Лабораторная работа № 2  

Изучение и исследование среды разработки 

электронных устройств PROTEUS 

1 Цель работы 

Изучить основы работы со средой проектирования электронных 
устройств Proteus. Изучить и исследовать методику разработки мик-
роконтроллерных устройств с помощью Proteus. 

2 Основные теоретические сведения 

Proteus (произносится протеус) – это пакет программ, объеди-

няющий в себе две основные программы: ISIS – средство разработки 

и отладки в режиме реального времени электронных схем и ARES – 

средство разработки печатных плат. Разработчиком пакета Proteus яв-
ляется фирма Labcenter Electronics (Великобритания).  

Отличие Proteus от аналогичных по назначению пакетов про-
грамм, например, Electronics Workbench Multisim, MicroCap заключа-
ется в развитой системе симуляции (интерактивной отладки в режимах 
реального времени и пошаговом) для различных семейств микрокон-

троллеров: MCS-51 (Intel), PIC (Microchip), AVR (Atmel) и др. Proteus 

имеет обширные библиотеки компонентов, в том числе периферийных 
устройств (светодиодные и ЖК-индикаторы, температурные датчики, 

часы реального времени), интерактивных элементов ввода-вывода 
(кнопки, переключатели, виртуальные порты) и виртуальных измери-

тельных приборов, которые не всегда присутствуют в других подоб-
ных программах. 

В данной лабораторной работе будет рассматриваться только 
программа ISIS. 

3 Порядок выполнения работы 

3.1 Запуск программы 

Внимание! Перед запуском программы создайте на диске F в сво-
ей рабочей папке (с именем, соответствующим вашей фамилии) новую 

папку с именем Lab2, в которую вы будете помещать исследуемые про-
граммы. Полный путь к этой папке может быть, например, таким: 

F:\MPT\Ivanov\Lab2 
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Запуск программы ISIS.exe выполняется с помощью ярлычка  
с надписью ISIS на рабочем столе компьютера. После запуска про-
граммы на экране появится основное окно. 

Самое большое пространство отведено под окно редактирования 
Edit Window. Именно в нем происходят все основные процессы соз-
дания, редактирования и отладки схемы устройства. 

Слева вверху расположено маленькое окно предварительного 
просмотра Overview Window. С его помощью можно перемещаться по 
окну редактирования. 

Под окном предварительного просмотра находится Object Selec-

tor – список выбранных в данный момент компонентов, символов  
и других элементов. Выделенный в списке объект отображается в ок-
не предварительного просмотра. 

Все возможные функции и инструменты Proteus доступны через 
меню, расположенное в самом верху основного окна, через пикто-
граммы, находящиеся под меню и с левой стороны основного окна,  
а также через «горячие клавиши». 

В самом низу основного окна расположены слева направо:  
� кнопки вращения и разворота объекта вокруг своей оси; 

� панель управления интерактивной симуляцией (выглядит как 
магнитофонная и функции такие же: Play – ПУСК, Step – ПОШАГО-

ВЫЙ РЕЖИМ, Pause – ПАУЗА, Stop – СТОП); 

� строка состояния (в ней отображаются ошибки, подсказки, те-
кущее состояние процесса симуляции и т. д.; 

� координаты курсора, отображаемые в дюймах. 

3.2 Разработка проекта управления светодиодом 

 от микроконтроллера 
Первым таким проектом будет разработка простейшего микро-

контроллерного устройства (МКУ), в котором МК управляет свето-
диодом, то есть включает или выключает его по определенной про-
грамме. 

3.2.1 Создайте новый проект, используя команду меню File > New 

Design. На экране появится диалоговое окно Create New Design, предла-
гающее выбрать шаблон для создания нового проекта. Щелкните левой 

кнопкой мыши по варианту DEFAULT (проект с параметрами по умол-
чанию), а затем по кнопке [OK]. На экране появится основное окно Pro-

teus с синим прямоугольником в окне редактирования, в котором вы бу-
дете создавать схему МКУ. 



 19

Принципиальная схема МКУ будет иметь вид, приведенный на 
рисунке 1. 
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Рисунок 1 – Cхема МКУ для управления светодиодом 

В качестве микроконтроллера выбран PIC16F84A. На схеме  
не изображены цепи питания и сброса МК, а также задания частоты 

тактового генератора. Все это эмулируется программно, и нет необ-

ходимости добавлять их в схему. Однако, если вы будете разрабаты-

вать проект до этапа изготовления печатной платы, то эти цепи и эле-
менты придется добавить. 

Итак, для построения схемы МКУ нам нужен микроконтроллер 
PIC16F84A, светодиод красного свечения и резистор с сопротивлени-

ем 300 Ом. Получить все эти элементы можно из библиотек компо-
нентов, которые имеются в Proteus.  

3.2.2 Выбор элементов из библиотек производится следующим 

образом. Необходимо перейти в режим компонентов Component Mode, 

щелкнув левой кнопкой мыши по соответствующей иконке на панели 

инструментов. Затем надо щелкнуть левой кнопкой мыши по кнопке [P] 

в верхнем левом углу переключателя объектов Object Selector, либо 
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дважды щелкнуть левой кнопкой мыши в поле Object Selector. На экра-
не появится окно Pick Devices библиотеки компонентов. 

Компоненты (элементы схем) можно выбирать по категориям 

Category, подкатегориям Subcategory, по производителю Manufacturer 

или же искать по ключевым словам Keywords. В случае, если вы знае-
те название элемента, то лучший способ – искать по нему. Итак, най-

дем микроконтроллер. Наберите в окне Keywords слово PIC16F84A.  

В окне результата Results появится строка с описанием выбранного 
компонента. Подведите курсор мыши к этой строке и щелкните левой 

кнопкой. Строка поменяет цвет на синий, что говорит о выделении 

данного компонента. Для перемещения выбранного компонента,  
в данном случае PIC16F84A, в список Object Selector нужно дважды 

щелкнуть левой кнопкой мыши по выделенной строке. 
Для выбора следующего элемента схемы – светодиода – очисти-

те строку Keywords и введите слово LED-RED (красный светодиод).  

В окне результата появится строка с описанием светодиода LED-RED 

из библиотеки ACTIVE. Щелкните левой кнопкой мыши по этой 

строке для выделения, а затем еще дважды для перемещения выбран-

ного элемента в список Object Selector. 

Для выбора следующего элемента схемы – резистора –очистите 
строку Keywords и введите слово RES (резистор). В окне результата 
появится список резисторов из библиотеки. Выберите строку RES 

DEVICE.    

3.2.3 Теперь, когда элементы выбраны, необходимо перейти  

к следующему этапу разработки – их размещению в окне редактиро-
вании. Начнем с микроконтроллера. Щелкните левой кнопкой мыши 

по строке с текстом PIC16F84A. В окне предварительного просмотра 
появится изображение микроконтроллера. Если расположение выво-
дов, то есть ориентация корпуса, соответствует исходной схеме, при-

веденной на рисунке 1, то переместите указатель мыши в середину 
окна редактирования и щелкните левой кнопкой. Контур микрокон-

троллера появится под указателем мыши и будет следовать за ним, 

когда мышь будет перемещаться по окну редактирования. Поместите 
контур в верхнюю часть окна и щелкните еще раз левой кнопкой мы-

ши. После этого изображение микроконтроллера прорисуется полно-
стью и будет помещено на схему. 

Теперь щелкните левой кнопкой мыши по строке RES. Изобра-
жение резистора появится в окне предварительного просмотра. Если 

его ориентация не соответствует рисунку 1, то можно развернуть его 
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нажатием на иконки вращения панели инструментов. Затем надо  
поместить курсор мыши в окно редактирования и щелкнуть левой 

кнопкой. Перемещая мышь, надо разместить контур резистора в нуж-

ном месте схемы) и еще раз щелкнуть левой кнопкой. 
Далее щелкните левой кнопкой мыши по строке LED-RED. Если 

ориентация светодиода будет соответствовать рисунку 1, то помести-
те его на схему в окне редактирования. 

Не хватает еще одного важного элемента – «общего провода», 
или «корпуса». Элементы такого типа выбираются в режиме Termi-
nals Mode, для чего требуется щелкнуть по иконке с соответствующей 
надписью на панели инструментов. После этого в окне Object Selector 
появится список доступных элементов. Точный русскоязычный экви-
валент этих терминов в настоящее время не определился. Будем на-
зывать эти элементы клеммами. Выберите из списка элемент Ground 
(«Земля», общий провод) и поместите его под светодиодом.  

3.2.4 Теперь необходимо соединить элементы между собой со-
гласно принципиальной схеме, приведенной на рисунке 1. Рассмот-
рим методику соединения или, по-другому, «разводки» на примере 
соединения вывода 6 (RB0/INT) микроконтроллера с выводом рези-
стора R1. 

Курсор мыши, при расположении его в произвольном участке 
схемы, имеет вид бесцветного карандаша. Подведите курсор к выводу 6 
(RB0/INT) микроконтроллера. Цвет курсора изменится на зеленый, а на 
выводе появится красный квадратик, означающий, что соединение воз-
можно. Щелкните левой кнопкой мыши. Курсор мыши изменится  
на бесцветный карандаш, чтобы показать, что происходит разводка,  
и предполагаемый путь будет следовать за движением мыши к концу 
проводника. При соприкосновении курсора с выводом резистора R1 
цвет курсора вновь изменится на зеленый и появится красный квадра-
тик. Это говорит о том, что соединение возможно. Щелкните левой 
кнопкой мыши. На схеме появится проводник, соединяющий вывод 6 
микроконтроллера с верхним выводом резистора R1. По аналогии вы-
полните соединения нижнего вывода резистора R1 с анодом светодиода, 
а затем катода светодиода с клеммой общего провода («Землей»). 

Замечание. Соединение элементов схемы между собой должно 
быть выполнено по методике, описанной выше. Если же вы просто 
состыкуете выводы элементов путем их перемещения по экрану  
(например, нижний вывод резистора R1 и верхний вывод диода D1), 
то соединения не будет. Это будет разрыв цепи, хотя визуально выво-
ды будут соединены вместе. 
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3.2.5 Теперь необходимо изменить значение сопротивления ре-
зистора на 300 Ом. С этой целью подведите курсор к изображению 

резистора R1 и дважды щелкните левой кнопкой мыши. Откроется 
окно редактирования свойств компонента. Введите в поле Resistance 

число 300 (сопротивление в омах), а затем нажмите кнопку [OK] для 
подтверждения выбора параметров. Итак, схема МКУ готова. 

Теперь нужно сохранить проект в вашей папке. Выберите пункт 
меню File > Save Design As… Раскройте папку f:\...\Lab2 и сохраните 
в ней проект под именем  led.dsn. 

Сверните окно Proteus. 

3.2.6 Следующим этапом проектирования МКУ является разра-
ботка программы работы микроконтроллера. Предположим, что после 
включения питания микроконтроллера (его сброса) светодиод будет 
мигать с частотой 1 Гц. Текст программы на языке mikroC может 
иметь следующий вид: 

 

/********************************************************** 

 led.c – программа управления светодиодом от микроконтроллера 
PIC16F84A 

**********************************************************/ 

void main( ) 

{ 

     TRISB = 0;                  // настроить выводы порта В на вывод 

     PORTB = 0;                // вывести нули на выводы порта В 

     while( 1 )                    // бесконечный цикл 
     { 

           PORTB = 0xFF;       // зажечь светодиод 

           Delay_ms(500);       // задержка на время 500 мс = 0,5 с 
           PORTB = 0;            // погасить светодиод 

           Delay_ms(500); 

      } 

}  

   

Замечание. Несмотря на то что для переключения светодиода 
требуется периодически выводить логические 1 и 0 только на линию 

RB0 порта В, в программе  led.c  с целью ее упрощения выводятся ну-
ли и единицы на все линии порта. Методы управления отдельными 

линиями портов МК будут рассмотрены в дальнейших лабораторных 
работах. 
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Выполните разработку программы в следующей последователь-
ности. 

Запустите программу mikroC PRO for PIC. С помощью команды 
New Project… запустите New Project Wizard. Создайте новый проект 
с именем led в папке f:\ … \Lab2. Выберите микроконтроллер 
PIC16F84A и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы  led.c  и сохраните его в папке (с помощью 
команды меню File > Save). Выполните построение проекта, исполь-
зуя команду меню Build > Build. При отсутствии ошибок построения 
закройте проект командой Project > Close Project.  

3.2.7 Теперь нужно проверить работу программы  led.c  в схеме 
МКУ с помощью Proteus. С этой целью разверните окно программы 
Proteus с проектом led.dsn.  

3.2.8 Далее необходимо записать hex-код разработанной про-
граммы в память МК или, как часто говорят, запрограммировать МК. 
С этой целью подведите курсор мыши на изображение микрокон-
троллера и дважды щелкните левой кнопкой. Откроется окно редак-
тирования свойств компонента Edit Component. В этом окне щелкните 
по кнопке в правой части строки Program File. Откроется окно  Select 
File Name с hex-файлами из папки  f:\ … \Lab2. Выберите файл с име-
нем led.hex и нажмите кнопку [Открыть]. Затем в строке  Processor 
Clock Frequency (тактовая частота процессора) выставьте 8 МГц. На-
жмите кнопку [OK] для подтверждения выбора параметров. В заклю-
чение щелкните левой кнопкой мыши по пустому месту схемы для 
снятия выделения (красного цвета) с МК. 

3.2.9 Для запуска программы на выполнение щелкните по кноп-
ке [Play], расположенной слева в нижней части экрана. Светодиод 
должен попеременно загораться и гаснуть с интервалом 0,5 секунды.  

Обратите внимание на маленькие квадратики около выводов МК, 
резистора и светодиода. Цвет этих квадратиков говорит об логических 
уровнях на выводах элементов в данный момент времени. Синий цвет – 
низкий, красный – высокий уровень. 

Остановить выполнение программы можно с помощью кнопки 
[Stop]. 

В заключение сверните окно Proteus. 
3.2.10 Задание 1 для самостоятельной работы. Необходимо раз-

работать программу работы МКУ, изображенного на рисунке 1 и вы-
полняющего следующий алгоритм. После запуска программы светоди-
од 4 раза загорается на 1 секунду и гаснет на 2 секунды. После четырех 
«миганий» светодиод окончательно гаснет. Тактовая частота МК равна 
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8 МГц. Цикл повторения организуйте с помощью оператора for( ).  
Программу назовите led2.c. В mikroC PRO for PIC создайте новый про-
ект led2 и поместите его в папку Lab2. Получите файл led2.hex для  
загрузки в память микроконтроллера. Проверьте работу программы  
с помощью Proteus, открыв проект (схему МКУ) led.dsn  из папки Lab2. 
Загрузите в микроконтроллер файл led2.hex  из папки Lab2. 

3.3 Разработка проекта управления  

от микроконтроллера семисегментным  

светодиодным индикатором 

3.3.1 Теперь разработаем МКУ, в котором микроконтроллер вы-

водит данные на семисегментный светодиодный индикатор. Принци-

пиальная схема такого МКУ может иметь вид, приведенный на ри-

сунке 2. В этой схеме используется индикатор с общими катодами. 

Сегменты индикатора подключены к выводам порта В, а общий вы-

вод индикатора (катоды светодиодов) – к общему проводу схемы. 

Сегмент индикатора будет светиться при высоком уровне на соответ-
ствующем выводе порта В. На изображении индикатора выводы сег-
ментов располагаются с левой стороны сверху вниз по порядку: a, b, 

c, d, e, f, g. 
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Рисунок 2 – Схема МКУ для управления индикатором 
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3.3.2 Создайте в Proteus новый проект, используя команду меню 

File > New Design.  

3.3.3 Откройте библиотеку компонентов и выберите из нее мик-
роконтроллер PIC16F84A.  

Для поиска индикатора выберите в окне Category пункт Opto-

electronics (оптоэлектронные приборы) и щелкните левой кнопкой 

мыши. Затем в окне Sub-category выберите строку 7-Segment Displays 

и также щелкните левой кнопкой. Выделите в окне Results строку 
7SEG-COM-CATODE 

Это 7-сегментный индикатор красного цвета свечения с общими 

катодами светодиодов. Щелкните два раза по строке, а затем закройте 
библиотеку. 

3.3.4 Теперь разместите элементы МКУ в окне редактирования. 
Вначале поместите микроконтроллер. Для удобства размещения уве-
личьте масштаб отображения элементов. Затем перейдите в режим 

Terminals Mode и выберите из списка клемму Ground. Поместите ее 
ниже общего вывода индикатора. 

3.3.5 Выполните соединение элементов между собой, согласно 
принципиальной схеме, приведенной на рисунке 2.  

После завершения разводки необходимо сохранить проект. Для 
этого выполните команду меню File > Save Design As… Раскройте 
папку f:\...\Lab2 и сохраните в ней проект под именем ind.dsn. 

3.3.6 Следующим этапом проектирования МКУ является разра-
ботка программы для МК. Пусть после включения питания на инди-

катор постоянно выводится определенный код символа, например, 
цифры 6. 

Текст программы на языке mikroC, реализующий заданный ал-
горитм, может иметь следующий вид: 

 

/********************************************************* 

ind.c – программа вывода на индикатор цифры 6 

**********************************************************/ 

char table[ ] =           // массив семисегментных кодов для индикатора 
{ 

     0x3F,                               // семисегментный код цифры 0 

     0x06,                               // семисегментный код цифры 1 

     0x5B,                              // семисегментный код цифры 2 

     0x4F,                              // семисегментный код цифры 3 
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     0x66,                              // семисегментный код цифры 4 

     0x6D,                             //  семисегментный код цифры 5 

     0x7D,                             //  семисегментный код цифры 6 

     0x07,                              //  семисегментный код цифры 7 

     0x7F,                              //  семисегментный код цифры 8 

     0x6F                               //  семисегментный код цифры 9 

}; 

void main( ) 

{ 

     char j;                   // переменная-индекс элементов массива table[ ] 

     TRISB = 0;                     // настроить линии порта В на вывод 
     PORTB = 0;                   // погасить индикатор 
     j = 6; 

     PORTB = table[j];      // вывод на индикатор семисегментного кода  
                                            // цифры 6 

} 

 

3.3.7 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем ind в папке f:\ … \Lab2. Выберите микроконтроллер 
PIC16F84A и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы ind.c и сохраните его в папке. Получите 
файл ind.hex для загрузки в память микроконтроллера. 

3.3.8 Теперь нужно проверить работу программы ind.c в схеме 
МКУ с помощью Proteus. С этой целью разверните окно программы 

Proteus с проектом  ind.dsn.  

3.3.9 Далее необходимо записать hex-код разработанной про-
граммы в память МК. С этой целью подведите курсор мыши на изо-
бражение микроконтроллера и дважды щелкните левой кнопкой. От-
кроется окно редактирования свойств компонента Edit Component.  

В этом окне щелкните по кнопке в правой части строки Program File. 

Откроется окно Select File Name с hex-файлами из папки  f:\ … \Lab2. 

Выберите файл с именем ind.hex и нажмите кнопку [Открыть]. Затем 

в строке Processor Clock Frequency (тактовая частота процессора) вы-

ставьте 8 МГц. Нажмите кнопку [OK] для подтверждения выбора па-
раметров. В заключение щелкните мышью по пустому месту схемы 

для снятия выделения (красного цвета) с МК. 



 27

3.3.10 Для запуска программы на выполнение щелкните по 
кнопке [Play], расположенной слева в нижней части экрана. Если на 
индикаторе появилась цифра 6, то все в порядке. 

Остановить выполнение программы можно с помощью кнопки 

[Stop].   

3.3.11 Задание 2 для самостоятельной работы. Используя схе-
му МКУ, приведенную на рисунке 3, проверьте работу программы, 

выполняющую следующий алгоритм. После включения питания мик-
роконтроллера на индикатор выводится цифра 5, а затем она начинает 
мигать с частотой 1 Гц (0,8 секунды светится и 0,2 секунды нет).  

Программу назовите ind2.c. В mikroC PRO for PIC создайте новый 

проект ind2 и поместите его в папку Lab2. Получите файл ind2.hex  

для загрузки в память микроконтроллера. Проверьте работу программы  

с помощью Proteus, открыв проект (схему МКУ) ind.dsn из папки Lab2. 

Загрузите в микроконтроллер файл ind2.hex из папки Lab2. 

4 Содержание отчета 

Наименование и цель работы. Схемы МКУ и тексты всех про-
грамм к заданиям для самостоятельной работы (комментарии в про-
граммах обязательны!). 

Контрольные вопросы 

1 Какие функции выполняет программный пакет Proteus? 

2 Из каких частей состоит пакет Proteus? 

3 Как выбираются компоненты принципиальной схемы в Proteus? 

4 Каким образом можно перемещать схему по экрану дисплея? 

5 Как можно удалить из схемы какой-либо компонент? 

6 Каким образом можно изменить величину сопротивления ре-
зистора на схеме? 

7 Как можно загрузить программу в микроконтроллер в среде 
Proteus? 
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Лабораторная работа № 3 

Разработка и исследование управляющих  

программ для PIC-микроконтроллеров 

1 Цель работы 

Изучить основы разработки и отладки управляющих программ 

на языке mikroC для микроконтроллеров семейства PIC16 с помощью 

интегрированной среды  mikroC PRO for PIC и пакета схемотехниче-
ского моделирования Proteus. 

2 Основные теоретические сведения 

В программах для микроконтроллеров часто требуется управлять 
отдельными линиями портов МК, а также опрашивать их состояния. 

Язык mikroC позволяет иметь доступ к отдельными битами ре-
гистров специальных функций. Это можно выполнить следующими 

способами: 

1 Указать имя регистра, а затем после знака точки как раздели-

теля идентификатор номера бита в регистре в виде: B0, B1, B2, B3, 

B4, B5, B6, B7, где В0 – младший бит. 
Например: 
 

// для порта С, настроенного на вывод 

PORTC.B0 = 1;        // вывести лог. 1 на 0-ю линию порта С 

PORTC.B7 = 0;        // вывести лог. 0 на 7-ю линию порта С 

         

INTCON.B7 = 1;      // Установить в 1 бит GIE разрешения глобальных 
                                  // прерываний  (7-й бит в регистре INTCON)  

 

Для управления отдельными битами регистров портов можно 
использовать поразрядные операции, например: 

 

PORTC.B1 &= 0;     // вывести лог.0 на 1-ю линию порта С 

PORTC.B2 |= 1;       // вывести лог.1 на 2-ю линию порта С 

PORTC.B4 ^= 1;      // инвертировать 4-й разряд порта С 

PORTC.B7 = ~PORTC.B7;  // инвертировать 7-й разряд порта С        
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2 Указать имя бита в регистре специальных функций, а затем 

идентификатор вида:  _bit. 

Например: 
 

GIE_bit = 1;                      // установить в 1 бит GIE в регистре INTCON 

 

Биты регистров данных (линий портов) обозначаются как: 
 

RA0, RA1, RA3 и т.п. для регистра PORTA; 

RB0, … , RB7  для регистра PORTB; 

RC0, … , RC7  для регистра  PORTC. 

          // для порта С, настроенного на вывод 

RC0_bit = 1;                    // вывести лог. 1 на 0-ю линию порта С 

RC7_bit = 0;                    // вывести лог. 0 на 7-ю линию порта С 

 

Для управления отдельными битами портов можно также ис-
пользовать поразрядные операции, например: 

 

RC1_bit &= 0;     // вывести лог.0 на 1-ю линию порта С 

RC2_bit |= 1;       // вывести лог.1 на 2-ю линию порта С 

RC4_bit ^= 1;      // инвертировать 4-й разряд порта С 

RC7_bit = ~RC7_bit;  // инвертировать 7-й разряд порта С        

 

Биты регистров направления портов обозначаются как: 
 

TRISA0_bit, TRISA1_bit  и т.п. для регистра TRISA; 

TRISB0_bit, … , TRISB7_bit  для регистра TRISB; 

TRISC0_bit, … , TRISC7_bit  для регистра TRISC.  

 

В управляющих программах для микроконтроллеров часто воз-
никает необходимость в формировании временных задержек. Компи-

лятор mikroC имеет так называемые встроенные функции задержки, 

которые формируют временные задержки программным методом. 

Наибольшее применение находят три функции: 

1 Delay_us(константа), где константа определяет величину за-
держки в микросекундах (константа – это целое число типа unsigned 

long в пределах от 1 до 4294967295); 
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2 Delay_ms(константа), где константа определяет величину за-
держки в миллисекундах ( константа – это целое число типа  unsigned 

long  в пределах от 1 до 4294967295); 

3 Vdelay_ms(переменная), где значение переменной определяет 
величину задержки в миллисекундах (переменная должна быть типа  
unsigned int, а величина ее в пределах от 1 до 65535). 

Примеры: 

 

Delay_us(100);                       // задержка на время 100 мкс 
Delay_ms(2000);                    // задержка на время 2000 мс = 2 с 
unsigned  int  time = 500; 

Vdelay_ms(time);                  // задержка на время 500 мс 

3 Порядок выполнения работы 

3.1 Создание папки для работы в mikroC PRO for PIC 

При выполнении лабораторной работы № 3 мы будем использо-
вать папку с именем Lab3, которую необходимо предварительно  
создать. 

С этой целью откройте вашу рабочую папку и создайте в ней  

(с помощью клавиши F7) новую папку с именем Lab3. 

В дальнейшем вы будете записывать и хранить в этой папке все 
файлы при выполнении лабораторной работы № 3. Полный путь  
к этой папке будет такой: 

F:\MPT\Ivanov\Lab3 

3.2 Исследование программ управления светодиодом 

3.2.1 Рассмотрим простейшее микроконтроллерное устройство 
(МКУ), в котором МК типа PIC16F877 управляет светодиодом, присое-
диненным к линии (разряду) RC0 порта C. Принципиальная схема тако-
го МКУ (при моделировании в среде Proteus) может иметь вид, приве-
денный на рисунке 1. При высоком уровне (логическая 1) на выводе 
порта RC0 светодиод горит, а при низком уровне (логический 0) на вы-

воде порта RC0 светодиод не горит. 
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Рисунок 1 – Принципиальная схема МКУ  

для управления светодиодом 

Рассмотрим программу, которая производит переключение све-
тодиода через интервал 0,5 с, т. е. с частотой 1 Гц: 

 

/********************************************************* 

led.c – программа  управления светодиодом 

**********************************************************/ 

void  main( ) 

{ 

       TRISC.B0 = 0;     // настроить 0-ю линию (RC0) порта С на вывод 

       PORTC.B0 = 0;                         // погасить светодиод 

       while(1)                                     // бесконечный цикл вывода 
       {     

              PORTC.B0 = 1;             // зажечь светодиод  

              Delay_ms(500);             // задержка на 500 мс 
              PORTC.B0 = 0;             // погасить светодиод  

              Delay_ms(500);             // задержка на 500 мс 
        } 

} 
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3.2.2 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 
New Project… запустите New Project Wizard. Создайте новый проект 
с именем led в папке f:\ … \Lab3. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы  led.c  и сохраните его в папке. Получите 
файл led.hex для загрузки в память микроконтроллера. 

3.2.3 Теперь надо проверить работу программы в «реальных» 
условиях. С этой целью запустите программу ISIS.exe пакета Proteus  
с помощью ярлычка с надписью ISIS на рабочем столе компьютера. 
Создайте новый проект, используя пункт меню File > New Design. 

На экране появится диалоговое окно Create New Design, предла-
гающее выбрать шаблон для создания нового проекта. Щелкните ле-
вой кнопкой мыши по варианту DEFAULT (проект с параметрами по 
умолчанию), а затем по кнопке [OK].  

3.2.4 Для построения схемы МКУ нам нужен микроконтроллер 
PIC16F877, светодиод красного свечения и резистор сопротивлением 
300 Ом. Получить все эти элементы можно из библиотек компонен-
тов, которые имеются в Proteus.  

Выбор элементов из библиотек Proteus производится следую-
щим образом. Надо щелкнуть левой кнопкой мышьи по кнопке [P]  
в верхнем левом углу переключателя объектов Object Selector, либо 
дважды щелкнуть левой кнопкой мыши в поле Object Selector. На эк-
ране появится окно Pick Devices библиотеки компонентов. 

Компоненты (элементы схем) лучше выбирать по ключевым 
словам Keywords (названиям элементов) следующим образом: 

� сначала найдите микроконтроллер. Для этого наберите в окне 
Keywords слово  PIC16F877; 

� затем выберите светодиод. Для этого очистите строку Key-
words и введите слово LED-RED (красный светодиод); 

� затем выберите резистор. С этой целью очистите строку Key-
words и введите слово RES (резистор). В окне результата выберите 
строку RES DEVICE; 

Теперь можно закрыть библиотеку. Для этого нужно закрыть 
окно библиотеки или, что проще, нажать клавишу Enter.  

3.2.5 Разместите элементы МКУ в окне редактирования. Внача-
ле поместите микроконтроллер. Для удобства размещения увеличьте 
масштаб отображения элементов. Разместите на схеме резистор и све-
тодиод согласно рисунку 1. 
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Затем перейдите в режим Terminals Mode, для чего требуется 
щелкнуть левой кнопкой мыши по иконке с соответствующей надпи-
сью на панели инструментов. После этого в окне Object Selector поя-
вится список доступных элементов. Выберите из списка клемму 
GROUND (Земля, общий) и поместите ее около светодиода. 

Выполните соединение элементов между собой согласно прин-
ципиальной схеме, приведенной на рисунке 1. 

3.2.6 Далее необходимо установить параметры компонентов 
принципиальной схемы МКУ.  

Подведите курсор на изображение резистора R1 и дважды 
щелкните левой кнопкой мыши. Откроется окно редактирования 
свойств резистора. Введите в поле Resistance число 300 (сопротивле-
ние). Щелкните по кнопке [ОК] для подтверждения выбора.  

3.2.7 После завершения разводки необходимо сохранить проект. 
Для этого выберите пункт меню File > Save Design As… В диалого-
вом окне найдите папку f:\...\Lab3  и сохраните в ней проект под име-
нем  led.dsn. 

3.2.8 Теперь можно проверить работу МКУ, однако перед этим 
необходимо записать hex-код разработанной программы в память МК, 
или, как часто говорят, запрограммировать МК. С этой целью подве-
дите курсор мыши на изображение микроконтроллера и дважды 
щелкните левой кнопкой. Откроется окно редактирования свойств 
компонента Edit Component. В этом окне щелкните по кнопке в пра-
вой части строки Program File. Откроется окно Select File Name  
с hex-файлами из папки f:\...\Lab3. Выберите файл с именем  led.hex  
и нажмите кнопку [Открыть]. Затем в строке Processor Clock Fre-
quency (тактовая частота процессора) выставьте 8 МГц. Нажмите 
кнопку [ОК] для подтверждения выбора параметров. Для запуска про-
граммы на выполнение щелкните по кнопке [Play], расположенной 
слева в нижней части экрана. Светодиод должен попеременно заго-
раться и гаснуть с интервалом 0,5 секунды. Остановить выполнение 
программы можно с помощью кнопки [Stop]. 

3.3 Исследование программы формирования меандра 
В различных управляющих и измерительных устройствах широ-

ко применяются периодические последовательности прямоугольных 
импульсов, у которых длительность импульса иt  равна паузе пt :

 

,2/пи Тtt   

где Т – период следования импульсов; Tf /1  – частота следования. 
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Последовательность прямоугольных импульсов с такими пара-
метрами часто называют меандром. Меандр легко сформировать про-
граммным методом с использованием функций временной задержки. 

3.3.1 Допустим, что требуется разработать МКУ, которое выдает 
на линию RC1 порта C микроконтроллера меандр с частотой 10 Гц 

(период 100 мс). Схема МКУ (при моделировании ее в среде Proteus) 

приведена на рисунке 2. 
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Рисунок 2 – Схема МКУ для генерации меандра 

Текст программы генерации меандра на языке mikroC следующий: 

 

/********************************************************* 

meander.c – программа генерации меандра частоты 10 Гц 

**********************************************************/ 

void  main( ) 

{ 

      TRISC.B1 = 0;      // настроить 1-ю линию (RC1) порта С на вывод 

       while(1) 

       { 

              PORTC.B1 = 1; 
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              Delay_ms(50); 

              PORTC.B1 = 0; 

              Delay_ms(50); 

        } 

} 

 

3.3.2 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем meander в папке f:\ … \Lab3. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы meander.c  и сохраните его в папке. Полу-
чите файл meander.hex для загрузки в память микроконтроллера. 

3.3.3 Для проверки работы МКУ запустите программу ISIS.exe 

пакета Proteus. Создайте новый проект, используя пункт меню  

File > New Design. Затем выберите из библиотек Proteus микрокон-

троллер PIC16F877.  

Разместите микроконтроллер в окне редактирования. Затем пе-
рейдите в режим  Virtual Instruments Mode (Режим виртуальных инст-
рументов), для чего требуется щелкнуть левой кнопкой мыши по 
иконке с соответствующей надписью на панели инструментов. В окне 
Object Selector появится список доступных элементов (приборов). 
Выберите из списка Oscilloscope (осциллограф) и поместите его в ок-
не редактирования согласно рисунку 2. Соедините канал A осцилло-
графа с линией RC1 порта C микроконтроллера.  

После завершения разводки необходимо сохранить проект.  
Для этого выберите пункт меню File > Save Design As… Раскройте 
папку f:\....\Lab3 и сохраните в ней проект под именем  meander.dsn. 

3.3.4 Теперь можно приступить к проверке работы МКУ. Сначала 
нужно записать hex-код разработанной программы meander.hex в па-
мять МК. Для проверки работы МКУ с помощью кнопки [Play] запус-
тите программу. Настройте осциллограф, чтобы на экране было ус-
тойчивое изображение импульсов. Замерьте период и длительность 
импульсов. Сравните полученные значения с указанными в програм-

ме. Остановите работу МК с помощью кнопки [Stop]. 
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3.4 Программирование и исследование  
процедуры опроса переключателя 

3.4.1 Рассмотрим теперь, как на языке mikroC выполняется оп-

рос состояния контактов переключателя (кнопки). На рисунке 3 при-

ведена схема МКУ (при моделировании ее в Proteus), в которой 

управление светодиодом D1 производится от переключателя (кнопки) 

SB1 по следующему алгоритму. Когда контакт SB1 замкнут, светоди-

од D1 горит, когда контакт SB1 разомкнут, D1 не горит. Рассмотрим 

два варианта программы управления светодиодом D1 от кнопки SB1. 

Для упрощения текста программы будем считать, что у кнопки SB1 

нет дребезга контактов. 

RA0/AN0
2

RA1/AN1
3

RA2/AN2/VREF-
4

RA4/T0CKI
6

RA5/AN4/SS
7

RE0/AN5/RD
8

RE1/AN6/WR
9

RE2/AN7/CS
10

OSC1/CLKIN
13

OSC2/CLKOUT
14

RC1/T1OSI/CCP2
16

RC2/CCP1
17

RC3/SCK/SCL
18

RD0/PSP0
19

RD1/PSP1
20

RB7/PGD
40

RB6/PGC
39

RB5
38

RB4
37

RB3/PGM
36

RB2
35

RB1
34

RB0/INT
33

RD7/PSP7
30

RD6/PSP6
29

RD5/PSP5
28

RD4/PSP4
27

RD3/PSP3
22

RD2/PSP2
21

RC7/RX/DT
26

RC6/TX/CK
25

RC5/SDO
24

RC4/SDI/SDA
23

RA3/AN3/VREF+
5

RC0/T1OSO/T1CKI
15

MCLR/Vpp/THV
1

U1

PIC16F877

R1

300

D1
LED-RED

R2
10k

SB1

 

Рисунок 3 – Принципиальная схема МКУ с управлением 

светодиодом от кнопки 

3.4.2 Сначала исследуем программу, в которой для опроса со-
стояния контактов кнопки используется оператор выбора  if … else: 

 

/********************************************************** 

led_but1.c – первая программа управления светодиодом от кнопки  

**********************************************************/ 
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void  main( ) 

{ 

     TRISB.B1 = 1;         // настроить 1-ю линию (RB1) порта В на ввод 

     TRISC.B1 = 0;       // настроить 1-ю линию (RC1) порта С на вывод 

     PORTC.B1 = 0;                  // погасить светодиод 

     while(1)                              // бесконечный цикл опроса 
     { 

           if(PORTB.B1 ==0)      // если контакт кнопки SB1 замкнут, то 
                 PORTC.B1 = 1;     // зажечь светодиод 

           else                               // иначе 
                 PORTC.B1 = 0;      // погасить светодиод 

      }    

} 

 

3.4.3 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем led_but1 в папке f:\ … \Lab3. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы  led_but1.c  и сохраните его в папке. Полу-
чите файл led_but1.hex для загрузки в память микроконтроллера. 

3.4.4 Теперь нужно проверить работу программы led_but1.c  

в схеме МКУ с помощью Proteus. С этой целью запустите программу 
ISIS.exe пакета Proteus VSM с помощью ярлычка с надписью ISIS  

на рабочем столе компьютера. Создайте новый проект, используя 
пункт меню File > New Design. В открывшемся диалоговом окне 
щелкните по варианту DEFAULT, а затем по кнопке [OK]. 

Для выбора элементов схемы из библиотек Proteus щелкните ле-
вой кнопкой мыши по кнопке [P] в верхнем левом углу переключате-
ля объектов Object Selector. На экране появится окно Pick Devices 

библиотеки компонентов. 
Компоненты (элементы схемы) выбирайте по ключевым словам  

Keywords (названиям элементов) следующим образом: 

� для выбора микроконтроллера в окне Keywords введите слово  
PIC16F877; 

� для светодиода введите слово LED-RED (красный светодиод); 
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� для резистора введите слово RES (резистор). В окне результата 
выберите строку  RES  DEVICE; 

� для выбора переключателя (кнопки) введите слово BUTTON 

(кнопка). В окне результатов выберите строку BUTTON ACTIVE.  

3.4.5 Разместите элементы МКУ (резисторы, светодиод и кнопку) 
в окне редактирования согласно рисунку 3.  

Затем перейдите в режим Terminals Mode, для чего требуется 
щелкнуть левой кнопкой мыши по иконке с соответствующей надпи-

сью на панели инструментов. После этого в окне Object Selector поя-
вится список доступных элементов. Выберите из списка клемму 
GROUND (земля, общий провод) и поместите ее около кнопки и све-
тодиода. Затем выберите из списка клемму POWER (питание). Вы-

полните соединение элементов между собой.  

Далее необходимо установить параметры резистора R1. Затем 

сделайте надпись SB1 около изображения кнопки на схеме. С этой це-
лью перейдите в режим Text Script Mode, щелкнув по иконке (значку)  
с одноименной всплывающей надписью на панели инструментов. За-
тем подведите курсор к изображению кнопки (примерно на 1 см выше) 
и щелкните левой кнопкой мыши. На экране появится окно редактиро-
вания текста Edit Script Block. Введите в поле Text слово SB1 и щелк-
ните по кнопке [ОК]. Надпись SB1 должна появиться около изображе-
ния кнопки на схеме МКУ. 

После завершения разводки необходимо сохранить проект. Для 
этого выберите пункт меню File > Save Design As… Раскройте папку 
f:\...\Lab3 и сохраните в ней проект под именем led_but1.dsn. 

3.4.5 Запишите hex-код программы led_but1.hex из папки Lab3  

в микроконтроллер. Для запуска программы на выполнение щелкните 
по кнопке [Play], расположенной слева в нижней части экрана. Со-
гласно алгоритму программы led_but1.c после запуска МКУ светоди-

од должен быть погашен. Нажмите кнопку SB1 на схеме МКУ, щелк-
нув по кружку активатора (красного цвета) около кнопки. Контакт 
кнопки замкнется, а светодиод D1 должен загореться. После этого 
вновь щелкните левой кнопкой мыши по кружку активатора. Контакт 
кнопки должен разомкнуться, а светодиод погаснуть. Теперь щелкни-

те по середине изображения кнопки. Контакт кнопки SB1 должен 

кратковременно замкнуться, а затем разомкнуться. В это время свето-
диод D1 должен загореться. Если все эти действия МКУ выполняет 
правильно, то можно сделать вывод, что программа работает согласно 
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заданному алгоритму. Щелчком по кнопке [Stop] остановите выпол-
нение программы. 

3.4.6 Теперь исследуем программу, в которой для опроса со-
стояния контактов кнопки SB1 используются операторы цикла while. 

Схема МКУ для этой программы приведена на рисунке 4.  
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Рисунок 4 – Вторая схема МКУ с управлением  

светодиодом от кнопки 

Особенностью схемы МКУ является отсутствие внешнего под-

тягивающего резистора на линии RB2 порта В, к которой подключе-
ны контакты кнопки. Дело в том, что в микроконтроллерах семейства 
PIC16 имеется возможность программного подключения к линиям 

порта В внутренних подтягивающих резисторов. Это выполняется 
сбросом в нуль седьмого разряда в регистре конфигурации (опций) 

OPTION_REG. Следует отметить, что программным методом можно 
подключить внутренние резисторы только к линиям порта В, настро-
енным на ввод: 
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/********************************************************* 

 led_but2.c -  вторая программа управления светодиодом от кнопки 

******************************************************** */ 

void  main( ) 

{ 

      TRISB.B2 = 1;               // настроить 2-ю линию  порта В на ввод 
      TRISC.B2 = 0;              // настроить 2-ю линию  порта С на вывод  

      PORTC.BC2 = 0;                           // погасить светодиод 

      OPTION_REG.B7 = 0;     // подключить внутренние 
                                   // подтягивающие резисторы к линиям порта В  

      while(1)                                  // бесконечный цикл повторения  
     { 

           while(PORTB.B2 == 1);   // ожидание замыкания контакта SB1 

                PORTC.B2 = 1;                 // зажечь светодиод 

           while(PORTB.B2 == 0);  // ожидание размыкания контакта SB1 

                 PORTC.B2 = 0;                // погасить светодиод   

      } 

} 

 

3.4.7 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем led_but2 в папке f:\ … \Lab3. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы  led_but2.c и сохраните его в папке. Полу-
чите файл led_but2.hex для загрузки в память микроконтроллера. 

3.4.8 Теперь нужно проверить работу программы led_but2.c  

в схеме МКУ с помощью Proteus VSM.  

Запустите программу ISIS.exe пакета Proteus. Создайте новый 

проект, используя пункт меню File > New Design. В открывшемся диа-
логовом окне щелкните по варианту DEFAULT, а затем по кнопке [OK]. 

Для выбора элементов схемы из библиотек Proteus щелкните 
мышью по кнопке [P] в верхнем левом углу переключателя объектов 
Object Selector. На экране появится окно Pick Devices библиотеки 

компонентов. Выберите необходимые элементы и разместите их на 
схеме согласно рисунку 4. После завершения разводки сохраните 
проект в папке f:\ … \Lab3 под именем led_but2.dsn. Запишите код 

программы из файла  led_but2.hex в память микроконтроллера. 
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3.4.9 Выполните проверку работы МКУ. Для этого с помощью 

кнопки [Play] запустите выполнение программы. Согласно алгоритма 
программы led_but2.c после запуска МКУ светодиод должен быть по-
гашен. Нажмите кнопку SB1 на схеме МКУ, щелкнув по кружку ак-
тиватора около кнопки. Контакт кнопки замкнется, а светодиод D1 

должен загореться. После этого вновь щелкните левой кнопкой мыши 

по кружку активатора. Контакт кнопки должен разомкнуться, а свето-
диод погаснуть. Теперь щелкните по середине изображения кнопки. 

Контакт кнопки SB1 должен кратковременно замкнуться, а затем ра-
зомкнуться. В это время светодиод  D1 должен загореться. Если все 
эти действия МКУ выполняет правильно, то можно сделать вывод, 

что программа работает согласно заданному алгоритму. Щелчком  

по кнопке [Stop] остановите выполнение программы. 

4 Содержание отчета 

Наименование и цель работы. Принципиальные схемы МКУ  

и тексты исследованных программ. 

Контрольные вопросы 

1 Как в языке mikroC выполняется управление отдельными би-

тами портов МК? 

2 Как выполняется ввод состояния линии порта МК? 

3 Как выполняется временная задержка в программах? 

4 Какой сигнал называется в электронике меандром? 

5 Как можно сформировать меандр с помощью PIC-микрокон- 

троллера? 

6 Как выполняется опрос состояния контактов кнопки? 

7 Как можно программно подключить к порту PIC-микрокон- 

троллера внутренние подтягивающие резисторы? 
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Лабораторная работа № 4 

Исследование совместной работы  

ЖК-дисплея и PIC-микроконтроллера 

1 Цель работы 

Изучить принципы построения алфавитно-цифрового жидкок-
ристаллического дисплея (ЖКД) с контроллером HD44780. Изучить  
и исследовать методы программирования его работы на языке mikroC 

для микроконтроллеров семейства PIC16. Исследовать методику про-
верки работы МКУ с ЖК-дисплеем с помощью среды моделирования  
Proteus. 

2 Основные теоретические сведения 

2.1 Структура жидкокристаллического дисплея 

Алфавитно-цифровые ЖКД, или по-английски LCD (Liquid 

Crystal Display), представляют собой недорогие и удобные модули, 

позволяющие сэкономить время и ресурсы при разработке новых из-
делий, при этом обеспечивающие отображение большого объема ин-

формации при хорошей различимости и низком энергопотреблении. 

Японская фирма Hitachi разработала специальную микросхему – 

контроллер HD44780 для управления подобными ЖК-дисплеями. 

Этот контроллер определил интерфейс, который стал стандартом  

«де-факто» для ЖК-дисплеев. Аналоги этого контроллера или со-
вместимые с ним по интерфейсу микросхемы выпускают множество 
фирм, среди которых Epson, Toshiba, Sanyo, Samsung, Philips. Большее 
число форм производят ЖК-дисплеи на базе данных контроллеров. 
Эти дисплеи можно встретить в самых разнообразных устройствах: 
измерительных приборах, медицинском оборудовании, промышлен-

ном и технологическом оборудовании, офисной технике – принтерах, 
телефонах, факсимильных и копировальных аппаратах. 

Контроллер HD44780 может управлять двумя строками по  
40 символов в каждой (для дисплеев с четырьмя строками по 40 сим-

волов используются два однотипных контроллера), при матрице сим-

волов 5 × 7 точек. Существует несколько различных стандартных 
форматов ЖК-дисплеев (количество символов × число строк): 8 × 2, 

16 × 1, 16 × 2, 16 × 4, 20×1, 20 × 2, 20 × 4, 40 × 2, 40 × 4. Примером 
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может служить ЖКД типа WM-C1602N-2YLY с 32 позиционными 

индикаторами (16 × 2 символов, размер 64 × 16,5 мм). Конструктивно 
этот дисплей представляет собой печатную плату с установленными  

на ней контроллером HD44780 и ЖК-индикатором. Плата содержит 
14-контактное поле, расположенное в нижней части, а также 2 кон-

такта (выводы питания подсветки) в правой части. Назначение выво-
дов поясняет таблица 1. 

Таблица 1 – Назначение выводов ЖК-дисплея 

Номер вывода Обозначение Функция 

1 VDD Напряжение питания (+5 В ) 

2 VSS Общий (земля) 
3 VEE Управление контрастом 

4 RS Сигнал выбора регистра 
5 R/W Сигнал чтение/запись 
6 E Сигнал разрешение 

7–14 D0-D7 Биты данных 
 

Основными чертами интерфейса контроллера HD44780 являют-
ся такие характеристики. 

Данные передаются по 4- или 8-разрядной шине данных, что 
определяется пользователем. Эти данные могут быть либо команда-
ми, либо символьной информацией. Использование 4-разрядного ре-
жима позволяет ограничить весь интерфейс семью линиями, однако 
процесс передачи данных будет немного более медленным, чем при 

8-разрядном режиме. 
Управление дисплеем выполняется с использованием трех линий: 

� линия RS (выбор регистра), которая определяет, будет переда-
ваться команда или символьные данные; 

� линия R/W (чтение/запись), которая определяет направление 
перемещения данных (R/W = 1 – чтение, R/W = 0 – запись); 

� линия Е (разрешение), которая выполняет функцию тактирова-
ния с целью синхронизации процесса передачи данных. 

Контроллер имеет простой набор команд, который позволяет 
управлять работой дисплея. В его состав входят команды инициали-

зации и сброса дисплея, управления положением и характеристиками 

курсора и т. д.  
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2.2 Библиотека функций управления ЖК-дисплеем 

Для облегчения разработки программ в интегрированной среде 
mikroC PRO for PIC имеются библиотечные функции для управления 
алфавитно-цифровым ЖК-дисплеем на основе контроллера HD44780 

с 4-разрядной шиной данных. Рассмотрим эти функции. 

Lcd_Init – эта функция инициализирует модуль ЖКД. 

Прототип: 
        void  Lcd_Init( ). 

Перед тем, как использовать эту функцию, необходимо указать 
соединение ЖК-модуля с выводами портов МК. 

Пример 
// Рассмотрим процесс инициализации ЖКД, присоединенного  

к порту C микроконтроллера. В таблице 2 указаны выводы ЖКД и со-
ответствующие им выводы порта С. Следует отметить, что в рассмат-
риваемых функциях не используется режим чтения из ЖКД, поэтому 
на вывод R/W дисплея ннужно подавать постоянно логический 0, для 
чего его можно просто соединить с общим проводом. 

Таблица 2 – Соединение выводов ЖКД и МК 

Наименование выводов ЖКД Наименование выводов порта С 

RS RC2 

E RC3 

D4 RC4 

D5 RC5 

D5 RC6 

D6 RC7 

 

// Присоединение выводов ЖКД 

sbit  LCD_RS  at  RC2_bit; 

sbit  LCD_EN  at  RC3_bit; 

sbit  LCD_D4  at  RC4_bit; 

sbit  LCD_D5  at  RC5_bit; 

sbit  LCD_D6  at  RC6_bit; 

sbit  LCD_D7  at  RC7_bit; 

// Направление выводов  
sbit  LCD_RS_Direction  at TRISC2_bit; 

sbit  LCD_EN_Direction  at TRISC3_bit; 

sbit  LCD_D4_Direction  at  TRISC4_bit; 

sbit  LCD_D5_Direction  at  TRISC5_bit; 
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sbit  LCD_D6_Direction  at  TRISC6_bit; 

sbit  LCD_D7_Direction  at  TRISC7_bit; 

// Инициализация модуля ЖКД 

Lcd_Init( ); 

 

Lcd_Out – эта функция выводит текст на ЖКД начиная с пози-

ции, которая указана как параметр функции. 

Прототип: 
void  Lcd_Out(char  row, char column, char  *text). 

Параметры: 

row – начальная позиция номера строки; 

column – начальная позиция номера колонки; 

text – текст для вывода, может быть строковая переменная или 

текст, помещенный в двойные кавычки. 

На рисунке 1 приведено расположение позиций дисплея фор- 
мата 16 × 2 с нумерацией колонок и строк. 

 
Номера колонок (позиций) 

Строка 1 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Строка 2 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Рисунок 1 – Расположение позиций дисплея формата 16 × 2 

Пример 
// Вывести текст “Hello!” на ЖКД, начиная со строки 2, колонка 1 

Lcd_Out(2, 1, “Hello!”); 

 

Lcd_Out_Cp – эта функция выводит текст на ЖКД, начиная  
с текущей позиции курсора. 

Прототип: 
void  Lcd_Out_Cp(char  *text); 

Параметр: 
text – текст для вывода, может быть строковая переменная или 

текст, помещенный в двойные кавычки. 

Пример 
    // Вывести на ЖКД текст “Student” с текущей позиции 

    // курсора 
Lcd_Out_Cp(“Student”); 
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Lcd_Chr – эта функция выводит на ЖКД символ в позицию, ко-
торая указана как параметр. 

Прототип: 
void  Lcd_Chr(char  row, char column, char out_char). 
Параметры: 
row – начальная позиция номера строки; 
column – начальная позиция номера колонки; 
out_char – символ для вывода, может быть строковая переменная 

или литерал, заключенный в одиночные кавычки. 
Пример 
// Вывести символ  d  в строку 2, колонка 3 

Lcd_Chr(2, 3, ‘d’); 
 
Lcd_Chr_Cp – эта функция выводит символ на ЖКД в текущую 

позицию курсора. 
Прототип: 
void  Lcd_Chr_Cp(char  out_char); 
Параметр: 
out_char – символ для вывода, может быть строковая переменная 

или литерал, заключенный в одиночные кавычки. 
Пример 
/ Вывести символ  m  в текущую позицию курсора 

Lcd_Chr_Cp(‘m’); 
 
Lcd_Cmd – эта функция посылает команду в ЖКД. 
Прототип: 
void  Lcd_Cmd(char  out_char); 
Параметр: 
out_char – команда для вывода. 
При выполнении данной лабораторной работы будут использо-

ваны только 4 команды: 
_LCD_CLEAR                  – очистка дисплея; 
_LCD_CURSOR_OFF      – отключение отображения курсора; 
_LCD_SHIFT_LEFT         – сдвиг текста на одну позицию влево 
_LCD_SHIFT_RIGHT      – сдвиг текста на одну позицию вправо 
Пример 
// Очистить ЖКД 

Lcd_Cmd(_LCD_CLEAR); 
// Отключить отображение курсора 

Lcd_Cmd(_LCD_CURSOR_OFF); 
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3 Порядок выполнения работы 

3.1 Создание папки для работы в mikroC PRO for PIC 

При выполнении лабораторной работы № 4 мы будем исполь- 
зовать папку с именем Lab4, которую необходимо предварительно  
создать. 

С этой целью откройте вашу рабочую папку и создайте в ней  

(с помощью клавиши F7) новую папку с именем Lab4. 

В дальнейшем Вы будете записывать и хранить в этой папке все 
файлы при выполнении лабораторной работы № 4. Полный путь  
к этой папке будет такой: 

F:\MPT\Ivanov\Lab4 

3.2 Вывод текстовой информации на ЖКД 

3.2.1 На рисунке 2 приведена схема МКУ, в котором ЖКД при-

соединен к выводам порта С микроконтроллера. 
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Рисунок 2 – Схема МКУ с ЖКД 

Рассмотрим программу, которая после запуска выводит на ЖКД 

различные сообщения. 
Текст программы на языке mikroC имеет следующий вид: 
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/********************************************************** 

lcd.c – программа вывода текста на ЖКД 

*********************************************************/ 

// Присоединение выводов ЖКД 

sbit  LCD_RS  at  RC2_bit; 

sbit  LCD_EN  at  RC3_bit; 

sbit  LCD_D4  at  RC4_bit; 

sbit  LCD_D5  at  RC5_bit; 

sbit  LCD_D6  at  RC6_bit; 

sbit  LCD_D7  at  RC7_bit; 

          // Направление выводов  
sbit  LCD_RS_Direction  at TRISC2_bit; 

sbit  LCD_EN_Direction  at TRISC3_bit; 

sbit  LCD_D4_Direction  at  TRISC4_bit; 

sbit  LCD_D5_Direction  at  TRISC5_bit; 

sbit  LCD_D6_Direction  at  TRISC6_bit; 

sbit  LCD_D7_Direction  at  TRISC7_bit; 

 

char  text1[ ] = “MikroElektronika”;       // текст для вывода на ЖКД 

char  text2[ ] = “Example”;                     // текст для вывода на ЖКД  

 

char  j;                                                      // переменная-счетчик                
int  time = 500;                                        // величина временной задержки 

 

void  main( ) 

{ 

      Lcd_Init( );                                           // инициализация ЖКД    

      Lcd_Cmd(_LCD_CLEAR);                // очистить ЖКД 

      Lcd_Cmd(_LCD_CURSOR_OFF);    // запретить отображение 
                                                                   // курсора 
              // вывод на ЖКД текста приветствия 
      Lcd_Out(1, 2, “Hello, world!”);          // вывод текста в 1-ю строку 
      Lcd_Out(2, 2, “I am PIC16F877”);     // вывод текста во 2-ю строку 
      Delay_ms(2000);                                 // задержка на время 2 с 
      Lcd_Cmd(_LCD_CLEAR);                // очистить ЖКД 

             // вывод на ЖКД текста 
      Lcd_Out(1, 1, text1);                           // вывод текста в 1-ю строку 
      Lcd_Out(2, 5, text2);                           // вывод текста во 2-ю строку  
      Delay_ms(2000); 
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          // сдвиг текста вправо 
      for(j = 0; j < 4; j++) 

      {  

            Lcd_Cmd(_LCD_SHIFT_RIGHT); 

            Vdelay_ms(time);                              // задержка на время 0,5 с 
       } 

          // бесконечный сдвиг текста влево и вправо 
       while(1) 

       { 

             for(j = 0; j < 10; j++) 

             { 

                   Lcd_Cmd(_LCD_SHIFT_LEFT); 

                   Vdelay_ms(time);                    // задержка на время 0,5 с 
              } 

              for(j = 0; j < 10; j++) 

              { 

                    Lcd_Cmd(_LCD_SHIFT_RIGHT); 

                    Vdelay_ms(time);                     // задержка на время 0,5 с 
              } 

        } 

 } 

 

3.2.2 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем lcd в папке f:\ … \Lab4. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы lcd.c и сохраните его в папке. Получите 
файл lcdhex для загрузки в память микроконтроллера. 

3.2.3 Далее нужно создать с помощью Proteus схему МКУ, при-

веденную на рисунке 2, для проверки работы программы  lcd.c. С этой 

целью запустите программу ISIS пакета Proteus. Создайте новый про-
ект, используя пункт меню File > New Design.  

3.2.4 Для выбора элементов схемы из библиотек Proteus щелк-
ните левой кнопкой мыши по кнопке [P] в верхнем левом углу пере-
ключателя объектов Object Selector. На экране появится окно Pick De-

vice библиотеки компонентов.  
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Для выбора ЖК-дисплея поставьте курсор мыши в окне Cate-

gory (Категория) на строку Optoelectronics (Оптоэлектронные прибо-
ры) и щелкните левой кнопкой. Затем в окне Sub-category выберите 
строку Alphanumeric LCDs и также щелкните левой кнопкой. В окне 
Results (Результаты) щелкните по строке  

LM016L    DISPLAY    16 × 2    Alphanumeric LCD 

Это алфавитно-цифровой жидкокристаллический двухстрочный 

дисплей для отображения 16 символов в строке. 
Для выбора микроконтроллера наберите в окне Keywords слово 

PIC16F877 и щелкните по строке в окне Results. 

Если выбранные элементы появились в списке окна Object Se-

lector, то закройте библиотеку.  
3.2.5 Теперь разместите микроконтроллер и ЖК-дисплей в окне 

редактирования согласно схеме на рисунке 2. Выполните соединение 
элементов между собой согласно схеме, приведенной на рисунке 2.  

После завершения разводки необходимо сохранить проект. Для 
этого выберите пункт меню File > Save Design As…. В диалоговом 

окне раскройте папку f:\ ... \Lab4 и сохраните в ней проект под име-
нем  lcd.dsn.  

Далее загрузите в микроконтроллер файл lcd.hex из папки Lab4, 

установите тактовую частоту 8 МГц.  

3.2.6 Для проверки работы МКУ с помощью кнопки [Play] за-
пустите выполнение программы.  

Убедитесь, что на дисплее появляются последовательно различ-
ные тексты, а затем производятся сдвиги текста влево и вправо. 

В заключение остановите выполнение программы и сверните 
окно Proteus. 

3.3 Задание для самостоятельной работы 

Для МКУ на рисунке 2 нужно разработать программу, которая  
в бесконечном цикле выводит на ЖКД «бегущую строку» текста “IDE 

mikroC PRO for PIC”. Сдвиг должен выполняться влево.  
Указание. В программе начните вывод на ЖКД в 1-ю строку  

с колонки 16. Сдвиг должен выполняться с задержкой 0,5 с. 
Разработанную программу назовите lcd2.c.  

В среде mikroC PRO for PIC создайте новый проект с именем lcd2 

(микроконтроллер PIC16F877, частота 8 МГц) и поместите его в папку 
f:\ … \Lab4. Получите файл lcd2.hex для загрузки в память МК. Про-
верьте работу программы с помощью Proteus, открыв проект (схему 
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МКУ) lcd.dsn из папки Lab4. В микроконтроллер загрузите файл 
lcd2.hex. 

С помощью кнопки [Play] запустите выполнение программы. 

Убедитесь в ее работе согласно заданного алгоритма. 
В заключение остановите работу МК с помощью кнопки [Stop]  

и сверните окно Proteus. 

4 Содержание отчета 

Наименование и цель работы. Тексты программ, принципиаль-
ную схему МКУ к заданию для самостоятельной работы (коммента-
рии в тексте программы обязательны!). 

Контрольные вопросы 

1 Каково назначение контроллера HD44780? 

2 Поясните назначение выводов ЖК-дисплея. 
3 Какие существуют способы соединения ЖК-дисплея с управ-

ляющим устройством? 

4 Какие библиотечные функции используются в mikroC PRO  

for PIC для управления ЖК-дисплеем? 

5 Объясните схему подключения ЖК-дисплея к PIC-микро-
контроллеру. 

6 Объясните порядок вывода текста на ЖК-дисплей. 
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Лабораторная работа № 5 

Исследование аналого-цифрового  

преобразователя PIC-микроконтроллера 

1 Цель работы 

Изучить принципы построения встроенного аналого-цифрового 
преобразователя (АЦП) микроконтроллеров семейства PIC16. Изу-
чить и исследовать методы программирования АЦП на языке mikroC. 
Исследовать методику проверки работы МКУ с АЦП и ЖК-дисплеем 
с помощью среды моделирования  Proteus. 

2 Основные теоретические сведения 

2.1 Аналого-цифровые преобразователи  

в PIC-микроконтроллерах 
Многие микроконтроллеры семейства PIC16 имеют встроенные 

многоканальные АЦП, используемые для преобразования аналогового 
входного напряжения в диапазоне от 0 до UDD (напряжение пита- 
ния МК) в цифровой код. Аналого-цифровые преобразователи выдают 
10-разрядный код, а число аналоговых каналов зависит от конкретного 
типа МК. Так, PIC16F877 имеет 8 аналоговых каналов. Для ввода анало-
говых сигналов обычно используются линии порта А, которые требует-
ся настроить на ввод. Реальная величина погрешности преобразования, 
характер использования выводов портов и скорость выполнения опера-
ций зависят от конкретного типа МК, а также тактовой частоты его  
работы. 

Модуль АЦП имеет внутренний делитель частоты, обеспечи-
вающий деление тактовой частоты МК в 2, 8 и 32 раза. Встроенный 
RC-генератор с частотой 250 кГц обычно используется для АЦ-преоб-
разования в тех случаях, когда сам МК переводится в энергосбере-
гающий режим SLEEP.  

2.2 Функции управления аналогово-цифровым  

преобразователем компилятора mikroC PRO 

Для облегчения разработки программ управления встроенным 
аналогово-цифровым преобразователем PIC-микроконтроллеров в биб-
лиотеке IDE mikroC PRO for PIC имеются две функции. 

ADC_Init – эта функция производит инициализацию внутренне-
го модуля АЦП микроконтроллера. При этом предполагается,  
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что АЦП будет тактироваться от внутреннего RC-генератора модуля,  
а выводы портов МК, используемые как аналоговые входы, сконфи-

гурированы на ввод. 

Прототип: 
void  ADC_Init( );  

Пример  
// Инициализировать модуль АЦП с использованием в качестве  
// аналоговых входов линии порта А – RA0, RA2, RA3 

// (аналоговые каналы AN0, AN1, AN2) 

TRISA = 0b00000111;    // Настроить линии порта А - RA0, RA1, RA2  

                              // на ввод, остальные на вывод 

……………………………….. 

ADC_Init( );  

 

ADC_Read – эта функция вводит аналоговое напряжение из за-
данного канала и запускает АЦП. Функция возвращает 10-разрядное 
двоичное число без знака (выходной код АЦП). Перед использовани-

ем этой функции модуль АЦП должен быть инициализирован. 

Прототип: 
unsigned  int  ADC_Read(unsigned  char  channel); 

Здесь параметр  channel (канал) представляет собой номер ана-
логового канала, из которого извлекается напряжение. 

Для микроконтроллера PIC16F877 номера аналоговых каналов 
соответствуют следующим выводам портов А и Е: 

Номер канала                              Вывод порта А или E 

        0                                                   RA0 (AN0) 

        1                                                   RA1 (AN1) 

        2                                                   RA2 (AN2) 

        3                                                   RA3 (AN3) 

        4                                                   RA5 (AN4) 

        5                                                   RE0 (AN5) 

        6                                                   RE1 (AN6) 

        7                                                   RE2 (AN7)  

Пример  
// Прочитать код из канала 2 модуля АЦП 

unsigned  int  adc_result;        // Объявление двухбайтной целой  

                                      // переменной  

……………………………………… 
adc_result = ADC_Read(2); 
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3 Порядок выполнения работы 

3.1 Создание папки для работы в mikroC PRO for PIC 

При выполнении лабораторной работы № 5 мы будем использо-
вать папку с именем Lab5, которую необходимо предварительно  
создать. 

С этой целью откройте вашу рабочую папку и создайте в ней  

(с помощью клавиши F7) новую папку с именем Lab5. 

В дальнейшем Вы будете записывать и хранить в этой папке все 
файлы при выполнении лабораторной работы № 5. Полный путь  
к этой папке будет такой: 

F:\MPT\Ivanov\Lab5 

3.2 Разработка МКУ для измерения и индикации  

величины аналогового напряжения  

3.2.1 Требуется разработать микроконтроллерное устройство 
(МКУ) на базе PIC16F877, которое измеряет аналоговое напряжение U1 

в диапазоне от 0 до +5 В и выводит результат измерения на  
ЖК-дисплей. Тактовая частота работы МК равна 8 МГц. Принципиаль-
ная схема МКУ (при моделировании ее в среде Proteus) приведена  
на рисунке 1.  
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Рисунок 1 – Схема МКУ для измерения аналогового напряжения 

На рисунке 1 потенциометр RV1 используется для изменения 
величины входного напряжения  U1 в пределах от 0 до +5 В (напря-
жение UDD = +5 В). Вольтметр PV1 служит для измерения действи-
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тельной величины входного напряжения U1, снимаемого с движка 
потенциометра RV1. На экран дисплея должен выводиться текст в ви-

де строки: величина напряжения U1 в вольтах, например: 
U1 = 2.534 V 

Текст программы работы МКУ на языке mikroC может быть 
следующий: 

 

/********************************************************* 

adc.c – программа измерения напряжения и вывода  на ЖКД 

*********************************************************/ 

// Присоединение выводов ЖКД 

sbit  LCD_RS  at  RC2_bit; 

sbit  LCD_EN  at  RC3_bit; 

sbit  LCD_D4  at  RC4_bit; 

sbit  LCD_D5  at  RC5_bit; 

sbit  LCD_D6  at  RC6_bit; 

sbit  LCD_D7  at  RC7_bit; 

// Направление выводов  
sbit  LCD_RS_Direction  at TRISC2_bit; 

sbit  LCD_EN_Direction  at TRISC3_bit; 

sbit  LCD_D4_Direction  at  TRISC4_bit; 

sbit  LCD_D5_Direction  at  TRISC5_bit; 

sbit  LCD_D6_Direction  at  TRISC6_bit; 

sbit  LCD_D7_Direction  at  TRISC7_bit; 

 

void  main( ) 

{    

     int  res_ADC;                        // переменная для хранения кода АЦП 

     int  mvolts;              // переменная для хранения напряжения в 
                                     // милливольтах  
     char  num;              // переменная для хранения цифр напряжения в  
                                   // вольтах 
     TRISA = 0x01;            // настроить линию RA0 на ввод  
     ADC_Init( );                   // инициализация модуля АЦП 

     Lcd_Init( );                    // инициализация модуля ЖКД 

     Lcd_Cmd(_LCD_CLEAR); 

     Lcd_Cmd(_LCD_CURSOR_OFF); 

     while(1) 
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    { 

          res_ADC = ADC_Read( 0 );                       // чтение кода АЦП 

          mvolts = ((long)res_ADC  * 5000) / 0x03FF;     // преобразование 
                                                                // кода АЦП в милливольты  

          Lcd_Cmd(_LCD_CLEAR); 

          Lcd_Out(2, 4, “U = “); 

          num = mvolts / 1000;               // извлечение единиц вольт 
           Lcd_Chr_Cp(48 + num);         // отображение числа в коде ASCII 

           Lcd_Chr_Cp(‘.’);                     // отображение десятичной точки 

           num = (mvolts / 100) % 10;    // извлечение десятых долей вольт     
           Lcd_Chr_Cp(48 + num);       // отображение числа в коде ASCII 

           num = (mvolts / 10) % 10;        // извлечение сотых долей вольт 
           Lcd_Chr_Cp(48 + num);       //  отображение числа в коде ASCII 

           num = mvolts % 10;            // извлечение тысячных долей вольт 
           Lcd_Chr_Cp(48 + num);       // отображение числа в коде ASCII 

           Lcd_Out_Cp(“ V”); 

           Delay_ms(2000); 

      } 

} 

 
3.2.2 Выполните разработку программы в следующей последо-

вательности. 
Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем adc в папке f:\ … \Lab5. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы adc.c и сохраните его в папке. Получите 
файл adc.hex для загрузки в память микроконтроллера. 

3.2.3 С помощью Proteus нужно создать схему МКУ, приведен-
ную на рисунке 1, для проверки работы программы adc.c. С этой це-
лью запустите программу ISIS пакета Proteus. Создайте новый проект, 
используя пункт меню File > New Design.  

3.2.4 Для выбора элементов схемы из библиотек Proteus щелк-
ните левой кнопкой мыши по кнопке [P] в верхнем левом углу пере-
ключателя объектов Object Selector. На экране появится окно Pick De-
vice библиотеки компонентов.  

Для выбора ЖК-дисплея поставьте курсор мыши в окне Cate-
gory (Категория) на строку Optoelectronics (Оптоэлектронные прибо-
ры) и щелкните левой кнопкой. Затем в окне Sub-category выберите 
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строку Alphanumeric LCDs и также щелкните левой кнопкой. В окне 
Results (Результаты) щелкните по строке  

 

LM016L     DISPLAY    16 × 2      Alphanumeric LCD 
 

Это алфавитно-цифровой жидкокристаллический двухстрочный 
дисплей для отображения 16 символов в строке. 

Для выбора микроконтроллера наберите в окне  Keywords  слово 
PIC16F877 и щелкните по строке в окне Results. 

Для выбора потенциометра наберите в окне Keywords слово 
POT-HG. Это потенциометр с активаторами, т. е. возможностью ин-
терактивного изменения положения движка. В окне результата дваж-
ды щелкните по строке POT-HG ACTIVE для занесения компонента  
в список окна  Object Selector. После этого закройте  библиотеку. 

3.2.5 Теперь разместите микроконтроллер и ЖК-дисплей в окне 
редактирования согласно схеме на рисунке 1. Для удобства размеще-
ния компонентов увеличьте масштаб их отображения. Затем размес-
тите потенциометр в окне редактирования согласно рисунку 1. Для 
выбора вольтметра подведите курсор мыши к значку на панели инст-
рументов с всплывающей надписью Virtual Instruments Mode и щелк-
ните левой кнопкой мыши. В окне Object Selector  появится список 
виртуальных приборов (Instruments). Выберите строку DC VOLTME-
TER (вольтметр постоянного напряжения) и щелкните левой кнопкой 
мыши. Затем разместите вольтметр в окне редактирования согласно 
рисунку 1. После этого перейдите в режим  Terminals Mode, для чего 
требуется щелкнуть левой кнопкой мыши по иконке с соответствую-
щей надписью на панели инструментов. Выберите из списка клемму 
GROUND (земля, общий провод), а затем клемму POWER (питание). 
Выполните соединение элементов между собой согласно принципи-
альной схеме, приведенной на рисунке 1. 

После завершения разводки необходимо сохранить новый про-
ект. Для этого выберите пункт меню File > Save Design As… Раскрой-

те папку  f:\...\Lab5, и сохраните в ней проект под именем  adc.dsn. 

3.2.6 Загрузите в микроконтроллер файл adc.hex из папки   

f:\ … \Lab5, установите тактовую частоту 8 МГц. 

Для проверки работы МКУ с помощью кнопки [Play] запустите 
программу. На экране ЖК-дисплея должен появиться текст с сообще-
нием о величине входного напряжения U1 в вольтах. Действительное 
значение этого напряжения на входе МК показывает вольтметр PV1. 

Если эти значения совпадают, все сделано правильно.  
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Далее можно проверить работу МКУ при различных значениях 
напряжения U1, которые можно задавать изменением положения 
движка потенциометра RV1. С этой целью подведите курсор мыши  

к активатору потенциометра RV1 со значком «+», и несколько раз 
щелкните левой кнопкой мыши. Наблюдайте за изменением положе-
ния движка потенциометра RV1, величиной напряжения на вольтмет-
ре PV1 и данными на экране ЖКД.  

Затем подведите курсор мыши к активатору потенциометра RV1 

со значком «–» и также несколько раз щелкните левой кнопкой мыши. 

Наблюдайте за изменением положения движка потенциометра RV1,  

величиной напряжения на вольтметре PV1 и данными на экране ЖКД.  

В заключение остановите выполнение программы МКУ  и свер-
ните окно Proteus. 

3.3 Задание для самостоятельной работы 

3.3.1 Требуется разработать МКУ, состоящее из микроконтрол-
лера PIC16F877, ЖК-дисплея и двух кнопок. МКУ должно измерять 
два аналоговых напряжения и выводить результаты на ЖК-дисплей. 

Схема МКУ (при моделировании ее в Proteus) приведена на рисунке 2. 
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Рисунок 2 – Схема двухканального вольтметра 

МКУ должно выполнять следующий алгоритм. После запуска 
программы и разомкнутых контактах кнопок  SB1, SB2 на дисплей 

выводится текст приглашения: «Нажмите только одну клавишу: SB1 

или SB2» в виде: 
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Press only one 

key: SB1 or SB2 

При нажатии кнопки SB1 (замыкании ее контакта) МК произво-
дит измерение напряжения U1, и на дисплей выводится результат  
в виде: 

U1 = 2.524 V 

При нажатии кнопки SB2 (замыкании ее контакта) МК производит 
измерение напряжения U2, и на дисплей выводится результат в виде: 

U2 = 4.105 V 

В случае одновременного нажатия двух кнопок SB1 и SB2 на 
экран дисплея выводится текст сообщения об ошибке (одновременно-
го нажатия кнопок) в виде: 

Error!  Two keys 

are pressed 

Программа должна производить опрос кнопок и измерение 
входных напряжений в бесконечном цикле. После каждого вывода  
на ЖКД должна быть временная задержка на 2 с. 

Разработанную программу назовите  voltmeter.c. 

Текст программы может быть следующий: 

 

/********************************************************* 

voltmeter.c – программа измерения двух напряжений с выводом 

 на ЖКД 

*********************************************************/ 

// Присоединение выводов ЖКД 

sbit  LCD_RS  at  RC2_bit; 

sbit  LCD_EN  at  RC3_bit; 

sbit  LCD_D4  at  RC4_bit; 

sbit  LCD_D5  at  RC5_bit; 

sbit  LCD_D6  at  RC6_bit; 

sbit  LCD_D7  at  RC7_bit; 

          // Направление выводов  
sbit  LCD_RS_Direction  at TRISC2_bit; 

sbit  LCD_EN_Direction  at TRISC3_bit; 

sbit  LCD_D4_Direction  at  TRISC4_bit; 

sbit  LCD_D5_Direction  at  TRISC5_bit; 
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sbit  LCD_D6_Direction  at  TRISC6_bit; 

sbit  LCD_D7_Direction  at  TRISC7_bit; 

 

int  res_ADC;      // переменная для хранения кода АЦП 

int  mvolts;          // переменная для хранения напряжения в  
                            // милливольтах 
char  num;           // переменная для хранения цифр напряжения в  
                            // вольтах 
char  get_sb;       // переменная для хранения состояния контактов  
                                      // кнопок SB1, SB2  

void  init( );                  // прототип функции инициализации 

void  out_U1( );   // прототип функции вывода на ЖКД напряжения U1 

void  out_U2( );  // прототип функции вывода на ЖКД напряжения U2   

void  out_invite( );       // прототип функции вывода на ЖКД  

                                     // текста приглашения 
void  out_error( );        // прототип функции вывода на ЖКД  

                                     // текста сообщения об ошибке                
void  main( ) 

{ 

      init( );                                           // вызов функции инициализации 

      while(1) 

     { 

           get_sb = PORTB & 0b00000011;    // чтение линий порта И и  

                                                    // и выделение разрядов RB1, RB0 

           switch( get_sb ) 

          { 

                case  0b0000 0011 :          // обе кнопки SB1, SB2 не нажаты 

                     out_invite( );           // вывод на ЖКД текста приглашения 
                      break; 

                case  0b0000 0010 :                // нажата кнопка SB1 

                      out_U1( );       // вывод на ЖКД результата измерения U1 

                      break; 

                case  0b0000 0001 :                // нажата кнопка SB2 

                      out_U2( );      // вывод на ЖКД результата измерения U2 

                      break; 

                default : 

                      out_error( );      // вывод на ЖКД сообщения об ошибке 
             } 

       } 
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} 

void  init( )                     // функция инициализации              

{ 

      ………….                // требуется написать самостоятельно для  
      ………….      // инициализации линий портов МК, АЦП и ЖКД  

} 

void  invite( )               // функция вывода на ЖКД текста приглашения 
{                                   // требуется написать самостоятельно  
      …………..             // для вывода на ЖКД текста: 
      …………..             //        Press only one 

}                                   //        key:  SB1 or SB2 

void  out_U1( )            // функция измерения напряжения U1 и вывода 
{                                   // результата на ЖКД 

      …………..             // требуется написать самостоятельно 
      ………….. 

} 

void  out_U2( )             // функция измерения напряжения U2 и вывода 
{                                    // результата на ЖКД 

       ……………           // требуется написать самостоятельно 
       …………… 

} 

void  out_error( )           // функция вывода на ЖКД сообщения  
                                       // об ошибке 
{                                     // требуется написать самостоятельно  
       ……………            // для вывода на ЖКД текста: 
       ……………            //      Error! Two keys 

}                                     //       are pressed 

 

3.3.2 Выполните разработку программы в следующей последо-
вательности. 

Запустите программу mikroC PRO for PIC. С помощью команды 

New Project… запустите New Project Wizard. Создайте новый проект 
с именем voltmeter в папке f:\ … \Lab5. Выберите микроконтроллер 
PIC16F877 и тактовую частоту 8 МГц. В окне редактора наберите 
текст исходной программы voltmeter.c и сохраните его в папке. Полу-
чите файл voltmeter.hex для загрузки в память микроконтроллера. 

3.3.3 Для проверки работы МКУ запустите программу ISIS.exe 

пакета Proteus. Для упрощения разработки схемы можно использовать 
файл проекта с именем adc.dsn. С этой целью выберите пункт меню 
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File > Open Design. В раскрывшемся диалоговом окне найдите папку 
f:\ … \Lab5 и выберите из нее файл adc.dsn. 

3.3.4 В схему из файла adc.dsn необходимо добавить кнопки.  

Их надо выбрать из библиотек Proteus по слову BUTTON. После вы-

бора всех необходимых компонентов выполните соединение элемен-

тов между собой согласно принципиальной схеме, приведенной на 
рисунке 2. Затем сделайте надписи элементов схемы. 

И в заключение необходимо сохранить разработанный проект. 
Для этого выберите пункт меню File > Save Design As… Раскройте 
папку  f:\ ... \Lab5 и сохраните в ней проект под именем  voltmeter.dsn. 

3.3.5 Загрузите в микроконтроллер файл voltmeter.hex из папки 

f:\ … \Lab5. установите тактовую частоту 8 МГц. 

Для проверки работы МКУ запустите проект на выполнение  
с помощью кнопки [Play]. На экране дисплея должен появиться текст: 

Press only one 

key: SB1 or SB2 

Если это произошло, то нажмите и зафиксируйте кнопку SB1. 

На экране дисплея должны появиться значения напряжения U1  

в вольтах.    
Далее разомкните кнопку SB1, нажмите и зафиксируйте кнопку 

SB2. На экране дисплея должны появиться значения напряжения U2  

в вольтах. 
И, наконец, замкните и зафиксируйте обе кнопки: SB1 и SB2.  

На экране дисплея должно появиться сообщение об ошибке в виде: 
Error!  Two keys 

are pressed 

В заключение проверьте правильность измерения напряжений 

U1 и U2 при различных положениях движков потенциометров RV1  

и RV2.  

Остановите выполнение программы и закройте окно Proteus. 

4 Содержание отчета 

Наименование и цель работы. Текст программы и принципиаль-
ная схема МКУ к заданию для самостоятельной работы (комментарии 

в тексте программы обязательны!). 
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Контрольные вопросы  

1 Сколько разрядов имеет выходной код АЦП микроконтролле-
ров PIC16? 

2 Какие библиотечные функции используются для управления 
АЦП? 

3 Как должны быть настроены линии порта МК, которые ис-
пользуются для ввода аналоговых сигналов? 

4 Какие действия должна производить программа для выполне-
ния АЦ-преобразования? 
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